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1 Overview

This guide is intended to explain how to use the Netop Portal.

1.1 Netop Portal

The Portal has two primary functions:
e Communication relay — the Portal acts as a secure relay service to
connect the Guest and Host modules.

e Management console - the Portal provides a browser-based interface
that allows users to:
o Manage access control
o View connected devices (Hosts)
o View audit logs
o Create remote sessions using a lightweight support console

1.2 Technical requirements — Portal website

The Portal provides a browser-based interface. Here is a list of supported

browsers and versions based on the operating system.

Operating Supported Browser
System

Windows Chrome latest version, Firefox latest version, and
Microsoft Edge based on Chromium and Internet Explorer
11.

macOS Chrome latest version, Firefox latest version, and Safari
latest version.

Linux Chrome latest version, Firefox latest version.
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1.3 Technical requirements - OnDemand Sessions web
client

The OnDemand Sessions functionality in the Portal requires a web
browser on the client-side. Here is a list of supported browsers and

versions based on the operating system.

Operating Supported Browser
System

Windows Chrome latest version, Firefox latest version, and
Microsoft Edge based on Chromium

macOS Chrome latest version, Firefox latest version, and Safari
latest version.

Linux Chrome latest version, Firefox latest version.

14 Technical requirements - OnDemand Sessions
desktop application

The OnDemand Sessions functionality in the Portal requires an
application to be executed on the device to be controlled. Here is a list of

supported operating systems and platforms for that application.

Operating Supported Platforms
System

Windows Platform: 32 & 64-bit
Windows 11: Home, Pro
Windows 10: Home, Pro, Enterprise and Education, IoT
Windows 8.1: Professional, Enterprise
Windows 7: Starter, Home Basic, Home Premium,
Professional, Ultimate, Enterprise (SP 0,1)
Windows Server 2019: Essentials, Standard, Datacenter
Windows Server 2016: Standard, Datacenter
Windows Server 2012 R2: Foundation, Essentials, Standard,
Datacenter

NOTE: For Windows 8.1, 7, and Windows Server 2012 R2,
the OnDemand Session desktop application works only if
TLS 1.2 is enabled.
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Operating Supported Platforms
System

macOS macOS 12 Monterey
macOS 11 Big Sur
macOS 10.15 Catalina
macOS 10.14 Mojave
macOS 10.13 High Sierra
i0S i0S 13
iOS 14 or higher
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2 General
2.1 Authentication

To log into the Portal, use the link and the credentials you used to set up
the trial account:

1. Specify the username and click on Next.

NET4P

2. Specify the password and click on Next.

If multi-factor authentication is enabled for your account, it is necessary
that you specify the code sent to you via email as a second factor of

authentication in the Portal.

NETSP

Sign in

admin@netop.com

Next

is site is protected by reCAPTCHA and the Google Privacy Policy and Terms
f Service apply.

Change user account




Netop Portal User’s Guide

NETS P

Email Code

asibincic@ativion.com

Your code has been sent to: as...@ativion.com

Email code

Use recovery code

Next

Change user account

If you do not have access to your e-mail account, you can use the

recovery codes to sign in.

Email Code

asibincic@ativion.com

Recovery code

Next

Change user account

Refer to the Generate recovery codes sub-chapter for details on how to

generate recovery codes.



Netop Portal User’s Guide

If LDAP authentication is set up for your account, authenticate in the
Portal using the following username format: domain identifier\LDAP

username and the domain password.

NETAP

Username

domain\user

Sign up here
Or find out more about our product

By =igning in, you agree to the terms of Ativion's Acceptable Use Policy.

If ADFS / Azure AD is set up, the steps are the same as for LDAP
authentication. The authentication is done on the customers' ADFS / Azure

AD authentication page.

The Portal now uses the reCAPTCHA v2 invisible feature offered by
Google as a means of protection against fraudulent attempts to logins,
activities, spam, and abuse. The reCAPTCHA feature is designed to be
friendly to humans. It uses advanced risk analysis techniques to
differentiate humans and bots apart from each other in order to protect the

Portal from spam.

2.1.1 Forgot Password

To reset your password, on the login page, specify your username and click on

9
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the Forgot your password? button. In the Recover password window, specify

the email address associated with your Portal account and click on the Send

button. You receive an email with instructions on how to change your
password.

10
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NOTE: The forgot password functionality does not work for LDAP, ADFS or
Azure AD authentication. To recover your domain password, contact your
system administrator.

2.2 User Interface

The graphical interface has three main areas:

e Menu sidebar (on the left) - allows you to navigate through the Portal.
The sidebar menu can be collapsed to increase the usable area of your
display, by clicking on the collapse button that can be found at the
bottom of the sidebar menu.

k ":T €©\, D 1@ DASHBOARD £ ContactNetop | w Purchase

A Dashboard
A

eeeeeeeeeeee

@ Applications

® Roles

11
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e Title bar (on the upper side) - allows you to perform general actions
like contacting support, accessing the My profile page, OnDemand

sessions, number of devices enlisted, number of users, and log off.

e Content area (right of the menu bar) - displays information such as
devices and users, activity, account information, documentation, and

recent updates.

| N | = @ /@> D & DASHBOARD ® Contact Netop (! Wr(mm\) 26/999

A Dashboard
ACCESS

' My sessions

16/25 141/10000

@ Devices & Users L Activity

& My devices

B My mobile devices

£ Account info O Recent updates

¥ Roles
&s Role assignments

® Downloads

SECURITY

@ Account security

A Authentication

B Logs

ACCOUNT

& Configuration

2.2.1 Filter Information

You can filter the information displayed in the content area by using the
filters available on each column header (in case a listing is displayed). Using

the filter improves the ability to locate specific items within the listings.

Clicking on the Filter icon on a column header displays an advanced filter,

which allows you to select the filter criteria.

12
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NET: @)\,D 2 2 Contact Netop 26/999 16/25 141/10000

A Dashboard sers (9 55, Invite users

ACCESS

-
]

& Applications

¥ Roles

28 Role assignments

@ Downloads

For example, you can use the Blanks filter option to help identify the users

and devices that aren't part of a group.

NOTE: When you filter by device group, you only see the device groups
that you have permissions for.

2.2.1.1 Multiple filters

You can set multiple filters to a listing.

h T

-
[ ]
-

2.2.1.2 Reload listing and clear filters

To remove a filter, from above the current listing, click on the filter you
want to remove. You can also reload the current listing and clear all the

filters.

13
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2.3 User Profile

You can view your Portal profile details by clicking on the Username
button in the title bar.

NETP B

£ Contact Netop @ 26/999 16/25 141/10000
admint

A Dashboard

& Attach to group # Edit x Remove

ACCESS

[2] [croue: ®tanks) x| [Fiter by name: jomna x

5" My sessions

-
-«

T 7]
& My devices o gimperosort Last seen online: B9 days ago

B My mobile devices

The My Profile tab displays information on the profile of the user currently
logged in.

NET4A4P

PROFILE

2 ContactNetop | T Purchiase

A Dashboard Netop Adminl

14
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2.3.1 Edit Profile Details

You can change your profile details by clicking on the Edit profile button.
The profile details become editable, except for the username which is non-
editable.

First Name User’s first name.

Last Name User’s last name.

Email The email address to which the user receives notifications
from the Portal and the multi-factor authentication code
(if enabled).

Email (MFA) Enables or disables the multi-factor authentication for the
User.

Default Possible options:

remote e Control through Guest

control e Control through browser

action

The option that you set here as the default remote control
action is the one that is displayed in the My devices tab
when you want to start a remote control session with a
device.

Make the profile updates that you want and click on the Save button to

store the updates.

NOTE: LDAP, ADFS and Azure AD users cannot edit their Portal profile.
2.3.2 Change Your Password

To change your password, go to your profile and click on the Change

password button.

NOTE: LDAP, ADFS and Azure AD users cannot change their password
from within the Portal.

15
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Specify and confirm a new password for your account.

A password is valid if it agrees with the following rules:
e minimum of 8 characters

e at least one uppercase letter

e at least one lowercase letter

e at least one numeric character

For the updates to take effect, click on the Save button.

2.3.3 Generate recovery codes

Recovery codes are used to log in to the Portal if you have multi-factor

authentication enabled.

To generate the recovery codes:
1. Login to the Portal.
2. Go to My profile.

3. Click on the Generate new codes button.

"
4 PROFILE 2 = | 1/5 1/2 43/50
NETHOP _/
a
M Dashboard Change password
ACCESS
" My sessions Personal info
. | ame
2 My devices Usemame
. ) First name

B My mobile devices

Last name
MANAGE
2t Users Email
2 Devices Type Account Owner

Multi-Factor Authentication Email code
L3 Groups

OnDemand Sessions Enabled
@ Applications

Default remote control action Control through Guest (default for this account)

¥ Roles

& Recovery codes

&% Role assignments

. If you don't have access to your email, you can use recovery codes to sign in. The codes come in sets of 10. Once you've used a recovery
L. Downloads code to sign in, it will become invalid.

When clicking on Generate new codes, a new set is generated and the old one becomes invalid. Please make sure you keep the recovery
codes safe because they are sensitive information.

SECURITY

@ Account security

16
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The recovery codes come in sets of 10. You can generate a new set at any
point. When generating a new set of recovery codes, the previous set
becomes automatically inactive. Also, after you‘ve used a recovery code to

sign in, the recovery code becomes inactive.

RECOVERY CODES

If you don’t have access to your email, you can use recovery codes to sign in.

1234-4567 2345-5678

You can print the codes or download them on your computer. We

recommend you keep the recovery codes safe due to their sensitive
information.

17
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3 How to remote control a device

The My devices and My sessions tabs list the online devices for which

you have access permissions as defined by the applied role assignment(s).

Refer to the Roles and Role assignments sub-chapter for more information.

If there is no device attached to the account, the options for installing the

Host are displayed.

To remote control a device, users can:
e Use the My devices tab to connect to an installed Host through an

installed Guest (Support Console) or by using the Control through

browser option. For more information, refer to the My devices —

permanent devices (attended and unattended) subchapter.

e Use the My sessions tab to connect to an OnDemand Session to
temporarily access a Windows, macOS or iOS device through the browser
option. For more information, refer to the OnDemand Sessions
subchapter.

e Use the My mobile devices tab to connect to a Host mobile device.

For more information, refer to the My mobile devices subchapter.

To connect to a Host device through the Guest (Support Console), it is

necessary that you download and install it on your device.

The Guest (Support Console) application can be installed on the
following operating systems:

e Windows

e macOS

e Linux

18



Netop Portal User’s Guide

Supported actions depending on the Host

Host operating system ——Actions

Windows - Remote Control
- File transfer
- Remote management (*)
- Chat (*)
Linux & macOS - Remote Control
- File transfer
* Guest version 12.70 or higher is required

You can download the Guest (Support Console) application on your

Windows device from the My devices tab.

19
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3.1 My devices — permanent devices (attended
and unattended)

Through the My devices tab you can:

¢ Remote Control a Host device through the Guest (Support Console)
e Remote Control a Host device through the browser

e Use the File transfer feature

e Use the Remote management feature

e Use the Chat feature

To view or use these options click on the dropdown menu button near the

Remote control button.

AT @\' () £3 MY DEVICES ® (,]

A Dashboard All Devices &> Download Guest (Support Console) Add device ¥

ACCESS
Filter by status: Online %

%’ My sessions
2 My devices

B My mobile devices

4 Hostname Y
am Online fo
2

= B Remote control

MANAGE [EZl Control through Guest

=] Control through browser
482 Users st

@ File transfer

Q Devices YJ Remote management

% Chat

L2 Groups

& Applications

¥ Roles

&% Role assignments

@ Downloads

SECURITY

& Account security

B Aaboaioaioo

NOTE: Using either the File transfer, Remote management, Chat
feature, or Control through Guest option, launches the Guest (Support
Console) application.

20
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3.1.1. Target device — Host setup
3.1.1.1 Windows 7 or later

Depending on your needs, you can:

e Install the Host on the device that you are on

e Install the Host on another device

e Automatically install the Host using a mass deployment tool

21
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Install the Host on the device that you are on

To install the Host on the device that you are on, proceed as follows:

1. Go to the My devices tab.

Ve
hll:-r &D\,D E3 MY DEVICES ] \E\J 1/5 1/2 43/50

M Dashboard All Devices 1> Download Guest (Support Console) » Add device »

ACCESS
@ Filter by status: Online %

" My sessions

&2 My devices

Searchin: @ All fields Hostname Alias Operating system Logged in user

# Hosthame Y

2 = Onfina fao DESKTOP-0 Dragos E1 Remote control hd

-

B My mobile devices

MANAGE

282 Users

&2 Devices

L3 Groups

& Applications

® Roles

2% Role assignments

@ Downloads

SECURITY

@ Account security

2. Click on the Add device button.

NET. @\,D 3 MY DEVICES 2 ContaceNetop | = Purc 1/5 1/2

#A Dashboard All Devices 4> Download Guest (Support Console) ¥

ACCESS

2 | [Fitter by stat

' My sessions

n
| J

B My mobile devices o = bost 4 [ Remote control

MANAGE

2% Users

&I Devices

L3 Groups

@ Applications

¥ Roles

2» Role assignments

@ Downloads

SECURITY

& Account security

22
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3. Click on the Host installer button.

h'I:T @\’D &3 MY DEVICES 2 Contact Netop !:_v:‘;,«:" 1/5 112 43/50

A Dashboard All Devices 4 Download Guest (Support Console) v ((Adddevice &)

oo
ACCESS T T m—r——" I @ Hostinstaller l
S My sessions — A & Host for other operating system
V]
& My devices n
Y
B My mobile devices =) a ¢ t & Remotecontrol ¥

MANAGE

a8 Users

& Devices

L3 Groups

@ Applications

¥ Roles

2» Role assignments

® Downloads

SECURITY

& Account security

4. When there is more than one deployment package defined in your

account, you are redirected to the Downloads page. Select the
deployment package and click on the Online installer button for the
download to start. Otherwise, the online installer is downloaded

automatically.

NET. @\, D \D DOWNLOADS £ ContsctNetop | (12 ‘

Thers is more than one valid deployment package in your account. If you want to add & device, select 3 deployment package, and then downlosd and run the installer.

¢ Dashboard

) Deployment packages D Add deployment package
' My sessions

& My devices

B My mobile devices

5. Click on the downloaded executable file.
The installation process begins, and it only requires that you accept the

Acceptable Use Policy.
23
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6. When the installation process is finished, the Host automatically
connects to the Portal.

41~ Netop Host - Running - | |ﬂ

File  View Action 5ession TJools Help

i WK AR [T

Communication ] Mames ] Messages ]
General l Connections ] Histaory ] Services

Status

| Running

Host ID
| DESKTOP-09FQLILIS

Address
| 192.168.201.13

[

19216820113 | @

3.1.1.2 macOS and Linux

3.1.1.2.1 macO0S

The Host for macOS window contains most of the Host for Windows
window elements, but the Host for macOS is limited in functionality when

compared to the Windows version and the setup is organized differently.

The Host for macOS enables a remote Guest to connect through the
TCP/IP, TCP/IP (TCP), HTTP, WebConnect, WebConnect 3 and the Portal
communication protocols to remote control the Host for a macOS device,
transfer files between the computers, and run a typed text chat session

between the computer users.

Prior to installation, verify that your computer meets the technical

requirements. For more information, refer to the macOS system

24
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requirements knowledge base article.

NOTE: To be able to install, make sure that the user logged on to the
computer is a local admin account. Using a domain account with local
admin privileges does not work.
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You can download and install the Netop for the supported macOS

versions from the files found on the Netop download page.

Open the relevant .dmg file downloaded from the Netop website and
double-click on the resulting . pkg file to display the installation wizard that
guides you through the Netop installation. Accept the license agreement
and specify the licensee name and the Netop license number when

prompted.

The Host includes the Host Program for macOS. The Host Program for

macOS loads and initializes when the computer operating system starts.

To use the Host on macOS 10.14 and above, the Host requires the
following permissions to be granted manually by the user:
e Accessibility

e Screen recording
NOTE: The Screen recording permission applies to macOS 10.15.

o Full Disk Access

@ Permissions required by Netop Host

/\

\ / If you need to remote control this device you need to grant Netop Host some permissions.

Accessibility

Netop requires Accessibility access so your mouse and keyboard can be controlled

remotely. Accessibility... (@

For more information, click here
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NOTE: The Host only prompts you for the unset permissions. You are
prompted to grant these permissions manually after you successfully install the
Host, start or restart the Host.

@ Permissions required by Netop Host
< \ If you need to remote control this device, you need to grant Netop Host some permissions.
4
Accessibility
Nr;::: e.r:t-:uires A ibility S0 your and keyboard can be controlled Accessibility... ®
Screen Recording
:e;:;o re':t:i:r::‘ Su‘f:r:::s%enc:rding access so remote users can see your screen Screen Recording... ®
Full Disk Access

Netop requires Full Disk Access to access files and folders on your Mac for File

Transfer. Full Disk Access... @

For more information, click here

To grant the Screen Recording permission, proceed as follows:

From the Apple menu, select System Preferences.

Click on the Security & Privacy icon.

Click on the Privacy tab at the top of the Security & Privacy window.
From the Security & Privacy window, select Screen Recording.

Click the lock to make changes.

To enable the Screen recording permission for the NetopHost, check

the NetopHost checkbox.

NOTE: The NetopHost application is added to the list only after the first
attempt to connect from a Guest to the Host.

To grant the Full Disk Access permission, proceed as follows:

From the Apple menu, select System Preferences.

Click on the Security & Privacy icon.

Click on the Privacy tab at the top of the Security & Privacy window.
From the Security & Privacy window, select Full Disk Access.

Click the lock to make changes.

To add the NetopHost, click on the + sign.
27



7.
8.

Netop Portal User’s Guide

Browse for the NetopHost.

Click on Open.

The grant the Accessibility permission, proceed as follows:

From the Apple menu, select System Preferences.

Click on the Security & Privacy icon.

Click on the Privacy tab at the top of the Security & Privacy window.
From the Security & Privacy window, select Accessibility.

Click the lock to make changes.

To enable the Accessibility permission for the NetopHost, check the

netophost checkbox.

NOTE: You cannot add the Accessibility permission manually. If you
remove the Accessibility permission for the “netophost”, you cannot set it
back again until you reinstall the Netop Host.

For more information on the macOS permission, refer to the following

knowledge base article.

The Host GUI for macOS does not start when the Host Program for macOS

loads.
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If the Host Program on macOS loaded, select Applications/NetopHost to
start the Host GUI for macOS.

@ @ Netop Host

eI History | Services | Communication | Names

Status
Running

Host ID

Host UUID
1d8e394a155¢123e3409270469533aed84 2e5f2d
Address

192.168.206.64

. O

To unload the Host GUI for macOS to hide the Host on the macOS window,

exit the NetopHost application.

The Host for macOS window contains most of the Host for Windows
window elements, but the Host for macOS is limited in functionality when

compared to the Windows version and the setup is organized differently.

The Host for macOS enables a remote Guest to connect through the
TCP/IP, TCP/IP (TCP), HTTP, WebConnect, WebConnect 3 and the Netop

Portal communication protocols to:

e remote control the Host

e transfer files between the devices
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e run a typed text chat session between the computer users

To change the setup options of the Host, click on the Options button from

the toolbar or on the Tools menu.

® ® Netop Host Configuration - Login

Select account for changing configuration

Username

Password

. Cancel
L J
Specify a valid macOS username. To change the setup options of the Host,

make sure that the wuser has the privileges to edit the

/Library/Application/Support/Netop/host/host.xml file.
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Type the corresponding password and click on the OK button. The Netop

Host Manager is displayed.

NetopHost Attribute
% NetopHost Portal Address
4% Configuration Name
4, Local configuration Enroliment Key
£ Addresslists Enable
o Host computer
%, Communication
£ Modem definitions
4. Network listen
Netop Portal
[¥ General
% Names
& Security
Help requests
Debug Log
Event Log
Tunnel Configuration
Host Monitor
* Guest users

IS%( #1

v  Value
portal.netop.com
Netop Portal
049pRdYw2phpyJQurZRbE7XWGTQiln2gGA...
Enabled

OK Cancel
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3.1.1.2.2 Linux

The Host includes the following programs:

e Netop Host Daemon (netophostd) - The Netop Host Daemon runs
when the computer operating system starts. A user with system user
privileges can start and stop the Netop Host Daemon.

e Netop Host Program (netophost)—The Netop Host Program loads
and starts when the Netop Host Daemon loads. If started, the
communication is initialized enabling a Netop Guest to connect. A user
can typically control the Netop Host Program from the Netop Host
GULI.

e Netop Host GUI (netophostgui) — The Netop Host GUI displays the
Netop Host graphical user interface. It does not automatically load when
the Netop Host Program loads. A user can load and unload the Netop
Host GUI.

NOTE: Only a user with system privileges can make changes to the Host
program options.

The Host uses the following communication protocols to connect to the
Guest:

e Portal

e Internet (TCP)

e LAN (TCP)

e UDP

e HTTP

e WebConnect and WebConnect3

The Host can be installed on a Linux device via:

e Software Installer
e Terminal
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Before you install the Host, make sure that your computer meets the
following minimum technical requirements. For more information, refer to

the following knowledge base article.

To download the Netop application for the supported Linux distributions

refer to the Netop download page.

e The download page includes separate installation or archive files for the
Guest and Host depending on your Linux distribution.
e The archive file contains the following files:
O ca-certificates.crt
o eula.txt
o install.pl
o 1nstallpubkey
O netop.pub
o netop-*.deb | netop-*.rpm (based on the Linux distribution in

use)

install.pl is a Perl script file that handles the installation process via the

terminal.

To list all the parameters of the install.pl Perl script, use the following

command:

install.pl --help

install.pl parameters table:

Function Command

[--help] Prints the help message and exits.

[--version] Prints the version info and exits.

[--serial <serial>] |Installs Netop Guest | Netop Host with the
<serial> number license key.

[--debug] Turns debugging on.
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[--license] Prints the Netop License.
[--autoinstall] Non-interactive installation assumes that you agree
with the Netop License.

Example:
For the non-interactive Host installations, use the following command:

3.1.1.2.2.1 Install the Host via the Software Installer

To install the Host via the Software Installer, proceed as follows:

1. Go to the file path of the extracted Host.

) netop-host
‘)’ Netop Host

Install

is a commercial program which allows remote users to see and share another user's actual desktop for purposes such as
technical support, troubleshooting, cooperation, server management, etc. Netop is not free software, you need to
purchase a license to use or copy Netop. Redistribution NOT permitted. Trial available upon installation. Run configure.pl
after installation (from /etc/NetopHost/cfg/).

Details

13.05-0ubuntu1

Never
Proprietary

netop-host_13.05-0ubuntu1_amdé64.deb
0 bytes

2. Double click on the netop-host_*.deb | rpm installation file. The

following window is displayed.

3. To install the Host, click on the Install button.

4, Specify the password for authentication.
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3.1.1.2.2.2 Install the Host via the terminal

To install the Host via the terminal, proceed as follows:
1. Go to the file path of the extracted Host.

2. Open up a terminal window.
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3. Use the following Perl script to initiate the installation process:

sudo perl install.pl

4. As part of the installation process, it is necessary that you accept the
Acceptable Use Policy.

dragos@dragos-virtual-machine: ~/Downloads/netop-host-13.05-ubuntu-64bit

File Edit View Search Terminal Help
Ativion End User License Agreement

This End User License Agreement ("EULA") governs your and any of your Users' use
of the Software. Your use of the Software constitutes your acceptance of this E
ULA, and you are responsible for your Userse use of the Software. Your use of th
e Software may otherwise be specified in an order document detailing the fees an
d support or other terms associated with the Software (an "Order"). Collectively
the Order, the Ativion Services Agreement, or another set of terms and conditio
ns as agreed, and this Ativion End User License Agreement govern your use of the
Software (together, the "Agreement"). All capitalized terms used but not define
d in this EULA shall have the meanings set forth in the Ativion Services Agreeme
nt. This EULA is between the Ativion affiliate entity identified on the applicaby
le Order (if no entity is identified then Impero Solutions Ltd.t/a Ativion, or I
mpero Solutions Inc. dba Ativion if you are based in the United States of Americ
a) ("Ativion"), and the customer identified on the Order or the individuals unde
r such customeres control ("you" or "User") and governs your use, access, and di
stribution of the Software provided to you by Ativion, including any documentati
on or related written materials associated with the same (collectively the "Soft

ware") as well as any other services or activities described in the Order.

BY CLICKING TO "ACCEPT" OR "AGREE" TO THIS EULA WHEN THIS OPTION IS MADE AVAILAB
LE TO YOU OR BY DOWNLOADING, INSTALLING OR USING THE SOFTWARE, WHICHEVER IS FIRS
T TO OCCUR, YOU (A) ACKNOWLEDGE THAT YOU HAVE READ AND UNDERSTAND THIS AGREEMENT
; (B) REPRESENT THAT YOU ARE 18 YEARS OF AGE OR OLDER; AND (C) ACCEPT THIS EULA
--More- -

5. Specify the type of license you want to use for the Host. The following
options are available:
a. Portal — all communication happens using the Portal (an Netop
Portal account is required)

i. Specify if you have a Portal account.
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dragos@dragos-virtual-machine: ~/Downloads/netop-host-13.05-ubuntu-64bit

File Edit View Search Terminal Help

r such customeres control ("you" or "User") and governs your use, access, and di
stribution of the Software provided to you by Ativion, including any documentati
on or related written materials associated with the same (collectively the "Soft
are") as well as any other services or activities described in the Order.
BY CLICKING TO "ACCEPT" OR "AGREE" TO THIS EULA WHEN THIS OPTION IS MADE AVAILAB
LE TO YOU OR BY DOWNLOADING, INSTALLING OR USING THE SOFTWARE, WHICHEVER IS FIRS
TO OCCUR, YOU (A) ACKNOWLEDGE THAT YOU HAVE READ AND UNDERSTAND THIS AGREEMENT
; (B) REPRESENT THAT YOU ARE 18 YEARS OF AGE OR OLDER; AND (C) ACCEPT THIS EULA
Do you accept this license? [yes/No] >yes

[3] Which type of license do you want to use for Netop Host? [T]rial / [pJortal
/ [cJustom: p
Validating license S
License key validated OK.
Your license has been saved.
] Starting netophostd (via systemctl): netophostd.service.

etop Host application has been installed and activated.

ou can start the Netop Host user interface by typing 'netophostgui' as a regula
r user. Please note that this only starts the GUI, the Host is already running a
s a different process.

hank you for using Netop Solutions Limited!

i. Specify the enroliment key for your Portal account.

Activities ] Terminal ~ Lu 10:28 L O
*, root@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-host-12.81-ubuntu-64bit™ = @

File Edit View Search Terminal Help

to the Licensed Software. Netop Business Solutions may use this information, as
long as it is in a form that does not personally identify You, to improve its
products or to provide services or technologies to You.

th respect to the Agreement, please contact us at Netop Business Solutions A/S,
Bregnerodvej 127, DK-3460 Birkerod, Denmark or +45 4590 25 25 or info@netop.co
m.

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is
explicitly prohibited for end-users or any other to vendor sign or cause vendor

signing of this module and thereby enabling this module to reach necessary sys
tem resources needed for the viewing of the screen and injection of input to th
e devices, that it otherwise could not reach. Doing so immediately revokes the
license to use this module.

E 10. Contact Information. Should you have any questions, complaints or claims wi

Do you accept this license? [yes/No/quit] >yes

[3] which type of license do you want to use for Netop Host? [T]rial / [pJortal
/ [c]ustom:
P
Validating license ...
License key validated OK.
Your license has been saved.
Do you have a Netop Portal account? [yes/No/quit] >y

Enrollment key : i

b. Trial —a 15-day fully-featured trial.
i. Specify if you have a Portal account.
ii. Specify the enrollment key for the Portal account.

c. Custom - specify the required license after buying the product.
i. Specify the License key for the Host.
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NOTE:
e You are prompted to specify a license key.

e If you do not specify a license key, Host automatically installs
itself in Trial mode.

ii. Specify if you have an Portal account.
iii. Specify the enrollment key.

NOTE: The Linux Host version 12.79 and above allow you to connect to
a UNIX device through the Portal and Windows Guest.

3.1.1.3 Windows XP & Vista

To install the Host on Windows XP & Vista, proceed as follows:
1. Go to the Portal under Settings > Downloads and click on the

deployment package to retrieve the Enrollment key.

Package details

Status

Description
Valid from
Valid to
Valid for

Enrollment key

2. Download the Host online installer from the following link.
3. Install the Host online installer.
NOTE: You can manually install it on the device you use or use a mass

deployment tool. Refer to the following knowledge base article for more
information on how to mass deploy the Host
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4. Configure the Host to use the Portal communication profile in the Setup
wizard with the default address and the above enrollment key. You can
also add a new Portal communication profile from Tools >
Communication profiles > New.

Communication Profile Edit

Communication Information

Communication Profile description:

| Portal Communication Profile
Cancel

dil

Communication Device:
INetop Portal ﬂ

Netop Portal
Address: | portal.netop.com

Enrollment Key: | XXOOOOGOOOOOOOOCOOOOXXX|

3.1.2 Technician device

Technicians can use one of the following options to control a target device:

e Connect through Guest
e Connect through browser (Browser Based Support Console)
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3.1.2.1 Connect through Guest

The Guest (Support Console) application is supported on the following
platforms:

e Windows 7 & higher

e macOS

e Red Hat Enterprise 7.x / CentOS 7.x
e Ubuntu 16.04 / 18.04

e SUSE Enterprise 12.x

To download and install the Guest (Support Console) application on a

Windows device, proceed as follows:

1. Go tothe My devices tab.
2. CI|ck on the Download Guest (Support Console) button.

2 Contact Netop !

I > Download Guest (Support Console] ¥ Add device ¥

NOTES:

e Supported Windows versions: Windows 7 & higher
e Administrator permissions are required for the installation

e No license is required for the Guest (this is a Portal only installation,
which means that the Guest only works with a Portal communication
profile)

When the Guest is installed, any previous Guest installations are
removed from the machine together with their corresponding settings

3. Click on the Windows option.

53 MY DEVICES

2 Contact Netop = | ® Furchase |

All Devices Add device v
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5. Click on the Finish button to finish the installation process.

<G Netop Guest Ex o O

File Connection Edit View Tools Help

Ry S b R PR G g 8 X () a0 P IR L )

[} Phonebook ™1 Quick Connect 2 Conmections 7% History % Help Request 4 Recordings “.i{ Script S Inventory

Host Communication profile
Mame:
| ~ MNetop Portal
Edit... New... Log out
»  Connect @ Filter Lg Connection Properties... ‘0 Reload
Hosts list
Host ID User Mame Unigue Host ID Operating System

r MNetop Network " Windows Network | Intel vPro |

For more information on how to download and install the Guest (Support

Console) application on a macOS or Linux device, click on one of the

following links:

e Linux Quick Install Guide
e mMacOS Quick Install Guide
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3.1.2.2 Connect through browser (Browser Based Support Console)

To connect to a Host device, click on the Remote control button near the
online device. The Remote control button launches the default remote

control action that it has been set to.

For more information on the Browser Based Support Console, refer to

the Browser Based Support Console User’s Guide.

The default remote control action for the Remote control button is set to

the Control through browser option.

For more information on how to set the default remote control action, refer to

the Set up the default remote control action subchapter.

To connect to the Host device, proceed as follows:
1. Gotothe My devices tab.

2. Click on the Remote control button to connect the Host device.

£3 MY DEVICES 2 Contact Netop 1/5 1/2 43/50
All Devices <}> Download Guest (Support Console) ¥ Add device v
[2] [Fiterby status: Online %
Searchin: (@) All fields
s
@ :
o @ Onneorsseconds [ — -

MANAGE

4t Users
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If the Host is configured to use Portal access rights, no other
authentication is requested from the user and the remote control

session starts.

5] Moo _ASBRI ¢ S )iy o W SHL 4T % 8, o- AKX

The first line of defence
in the digital world. |

000

Once logged in, the remote support session provides access permissions

as defined by the role assigned in the Portal.

Keys not captured by the operating system, or the browser are added to

the top menu.

For Windows these include:

e Windows key
e CTRL

o ALT

e SHIFT

For macOS these include:

Command key
Control
Option

Shift

MW TR WUMG @ Seansd JIIRY 0. 8 CHAL AT SHFT ). @ Al K

Selecting one of the keys within the console, and then pressing any key on

your keyboard, triggers the combination of those keys to be sent to the
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target device. Once the keyboard key is released, the button in the

browser menu is unclicked.

To use a key (e.g., SHIFT) multiple times, double-click on the button and

the key stays engaged. To release the command, click on the button again.

Using the console, you can send a variety of Windows commands using

the power button options.

These include:

e Logout

e Lock

e Restart

e Shut down

e CTRL + ALT + DEL

If the Host has multiple monitors, while in a remote control session, you
can change the host monitor to be displayed on the screen. Click on the

View button from the main menu and selecting the desired monitor.

Other options that are available include:
e Toolbar minimization

e Close session button

3.2 OnDemand Sessions

In many environments, end-user computers have no administrative or
organizational relationship with the help desk center from which they

request help.

Help desk centers face three major challenges to offer service to these
end-user computers:

e connectivity problems through end-user firewalls
e software maintenance
e licensing issues
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The Portal includes the OnDemand Sessions feature, which offers help
desk centers remote control of Windows-based devices across the Internet
without pre-installing software or configuring firewalls. Furthermore,
licensing depends solely on the number of help desk employees or

supporters — and not the number of end-users.

The OnDemand Sessions contains the Browser Based Support
Console, a downloadable Netop OnDemand application, and the
connectivity and role-based access provided by the Portal. Technicians can
connect to the target Host device, by clicking on the Start session button

from the My sessions tab.

OnDemand Sessions are well-suited to the vast and fast-growing market of
Internet Service Providers, telephone companies, outsourced help

desks, and call-centers.

The Portal allows a support technician to define OnDemand Sessions
and to share the session details with someone else, to view or control their
device. This can be done without installing anything on the remote device,
by running a single-use and disposable OnDemand application on the

device, when necessary.

The OnDemand Sessions are valid only for one remote connection from the
support technician to the device and are deleted automatically after the

connection is closed.

NOTE: If you have an incompatible OnDemand client (i.e., you do not have
the latest version of it) you are requested by the Portal to update it to the
latest version.
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3.2.1 Browser Based Support Console — OnDemand
Sessions

To create a new OnDemand Session, proceed as follows:

1. Access the My sessions tab from the menu on the left.

AT ‘©\ D % MY ONDEMAND SESSIONS - A

£ Contact Netop |\\! Purchase | 1/5 1/2 43/50

#A Dashboard All OnDemand Sessions ()

ACCESS -

[2] Resuts can be fitered using the ¥ on each column
N’ My sessions
v

& My devices

B My mobile devices

428 Users
&I Devices

L3 Groups

& Applications

W Roles

@ Downloads

2. Click on the Create session button.

Create a new session X

Have the remote user go to:

Copy link

Or send the link by email

Send

This automatically creates a one-time session key and provides you with

several ways of sharing the session details with another user.
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To copy the link to the clipboard, click on the Copy link button.

& N

Create a new session X

Have the remote user go to:

Copy link

Or send the link by email

Send

3. To send the link by email, specify the email of the user in the “Remote

user’s emaill’ entry field and click on the Send button.

Create a new session

Have the remote user go to:

Copy link

Or send the link by email

Send
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4. Once the remote user accesses the link received from the support

technician, a custom download page is shown.

NE IS/

ONDEMAND SESSION

u | understand

Session key 901219828

Download for macOS ‘ v

Do you already have Netop Agent installed on your Mac?

Looking for OnDemand for iPhone? Scan the QR below.

NOTE: The Portal detects the platform that you use to access the
OnDemand session link and displays the corresponding download link.

The remote user first needs to acknowledge that the link was provided by
a trustworthy source before being allowed to download the OnDemand

application.
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When you create an OnDemand Session, you receive a browser
notification on the Guest device. Click on the notification to go to the

OnDemand session queue.

NE IS/

THANK YOU FOR DOWNLOADING
NETOP AGENT

To allow website notifications in the browser, proceed as follows:
e For Chrome*
Open the Chrome internet browser.

In the address search bar, specify portal .netop.com.

Click on the “View Site Information” button (the lock icon in the search
bar).
4. Select “"Allow” from the “"Pop-ups and redirects” drop-down menu.

* Latest version
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e For Firefox”

1. Open the Firefox internet browser.

2. In the address search bar, specify portal .netop.com.

3. To view the Site information, click on the lock icon in the address

search bar.

&« C C‘ . = B https://ponal.netop.comﬂ

|_‘ul'er|'ficat de: Amazon_l:rmation for portal.netop.com

E] Connection secure >

Clear cookies and site data...

A Dashboard

4. Click on the right arrow.
« C O 8 #= B portalnetop.com

Site information for portal.netop.com

B Connection secure >

Clear cookies and site data...

M Dashboard

5. Click on the More Information button.
< C O B s & portalnetop.com

< Connection security for portal.netop.com

B You are securely connected to this site,

Verificat de: Amazon

A Dashboard More information

* Latest version
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6. Click on the Permissions tab.

& Page Info — https://portal.netop.com/ = O X

o Bt |&a

ﬁenéral Media | Permissions | Security

Permissions for: hitps://portal.netop.com

Access MIDI devices
Use Default Always Ack Allow Block

Access MIDI devices with SysEx support
Use Default Always Ask Allow Black

Access virtual reality devices

Use Default Always Ask Allow Block

Access your location

Use Default Always Ask Allow Block
Autoplay

Use Default Allow Audio and Video Block Audio Block Audio and Video
Install add-ons

Use Default Always Ask Allow Block

Open pop-up windows
Use Default Allow @ Block

Override keyboard shortcuts

Help

7. Uncheck the “Use default” check button for the “"Send Notifications”

permission.
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8. Select the “Allow” option.

@& Page Info — hitps.//portal.netop.com/ — O *

o B | &

ﬁenéral Media  Permissions  Security

Permissions for: https://portal.netop.com

Install add-ons

Use Default Always Ask Allow Block
Open pop-up windows

Use Default Allow  (®) Block

Override keyboard shortcuts
Use Default Allow Block

Select speakers
Use Default Always Ask Block

Send notifications

"] Use Default () Always Ask | @® Allow | Block
Set cookies
Use Default Allow Allow for Session Block

Share the screen

Use Default Always Ask Block

Store data in persistent storage

Help

e For Safari”
1. Open the Safari internet browser.

2. In the address search bar, specify portal.netop.com.

* Latest version
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3. In the Safari menu, go to Preferences.

@ Safari File Edit View Histor

About Safari
Safari Extensions...

Preferences...

Privacy Report...

Settings for This Website...
Clear History...

Services B
Hide Safari #EH
Hide Others X 3¥#H
Quit Safari #Q |

4. In the Preferences window, click on the Websites icon and then on

Notifications.
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5 Click on the dropdown button corresponding to the

portal.netop.com and select Allow.

isswords Search Security Privacy Websites Extensions Advanced

Edit Tags
General

These websites have asked for permission to show alerts in Notification Centre:

Content Blockers

% portal.netop.com Allow <

® Auto-Play
E Page Zoom
n Camera
n Microphone

Screen Sharing
=" Location

o Downloads

. Notifications

) + Allow websites to ask for permission to send notifications
. Pop-up Windows

NOTE: To receive OnDemand browser notifications, make sure that
notifications are allowed in the browser.

3.2.2 Start an OnDemand Session application on a
Windows machine

1. Once the OnDemand application is executed, a UAC prompt might be

displayed, asking the user to elevate the application.

If the elevation is granted, the support technician can fully control elevated
applications (i.e., Task Manager) as well as UAC prompts, while required
Firewall exceptions are automatically added to the system. If the elevation

is not granted, the OnDemand application still runs and is not elevated.
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The support technician can connect, and the elevated applications are not

controllable with keyboard and mouse.

NOTE: While an elevated application is in the foreground and if the
OnDemand application was not elevated, keyboard and mouse control are
unavailable, until the user on the controlled machine switches to a non-
elevated application.

2. After the elevation is granted or denied, the OnDemand application

starts and waits for a support technician to connect.

£ Netop Agent *

NET P

® Waiting for assistance...

Disconnect
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3.2.3 Initiate an OnDemand Session remote connection

To initiate an OnDemand session, proceed as follows:

1. Within the Portal, go to the My sessions tab.

| V| = @ 4@\' ™ %° MY ONDEMAND SESSIONS ® Contact Netop \/! Pu(hss;\ 115 1/2 43/50

# Dashboard All OnDemand Sessions (o %0 Create session

@ Results can be filtered using the ¥ on each column

&3 My devices

B My mobile devices

& Applications

¥ Roles

s Role assignments

@ Downloads

The displayed queue includes all the OnDemand Sessions started by
remote users and the time since they are waiting for a connection. Only the

running OnDemand Sessions can be seen in the queue.

NOTE: The Session key column includes icons for the permissions when
connecting to that device, as granted by the role assignments for the
current user.

Refer to the Roles and Role assignments sub-chapter for more information.

Only the running OnDemand Session can be seen in the queue. The
OnDemand Sessions stay in the queue for 1h before being automatically
disconnected. An OnDemand session key is valid 24h since it was

created.
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Click on the Start session button. The Control through browser page

starts in a new tab.

Connected

Waiting for the remate user ta confirm acces:

NOTE: As an alternative to starting the session, the support technician can
reject any session in the queue. This automatically disconnects the
OnDemand application and disables the OnDemand session. A new
OnDemand session is necessary to be created and sent to the remote
user for a new remote session to be initiated.

2. The remote user needs to allow the support technician access to the

device before the remote session starts.

<, Metop Agent x
NETe-P

Elvis Riza would like to connect to your device. Do
you want to allow the technician to connect?

The technician will be able to:

View remote screen

- Use keyboard and mouse
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3. Once access is granted, the remote session starts.

NETA P

Secure Remote
Access Software

Netop reduces downtime, improves reliability, and simplifiesthe complexity of modern remote
device management without compromising security

SECURE, REMOTE SUPPORTS LEGACY ON-PREMISE, CLOUD ENGINEERED FOR
ACCESS SOFTWARE COMPUTE RESOURCES ORH 10 COMPLEX SYSTEMS

The Browser Based Support Console toolbar includes virtual key
modifiers to use during the remote session. Each of the 4 key modifiers has 3
possible states: off, on, and always on (use it by double-clicking on the
key maodifier). These key modifiers help send various key combinations to
the remote machine, whenever the physical keyboard cannot be used for
this. The View menu allows the support technician to switch between Fit

To Screen and Actual Size for the displayed image.
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4. The remote user sees a natification that the session has started, along
with information about the support technician’s name and the granted
permissions. The remote user can close the session at any moment, by
clicking on the Disconnect session button, or by using the keyboard

hotkey (CTRL + SHIFT + X).

Settings

Display
@ on

Windows HD Color

s & actions

Storage

------

NOTE: Using the disconnect hotkey closes the session immediately,
without confirmation. This is done to make sure the remote user has an
unobstructed method of closing an ongoing session.

6. Once the remote session is closed, the support technician is notified

about it in the Browser Based Support Console page.

Disconnected

The other party ended the session. Close this tab in order to return to the Portal.
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3.2.4 OnDemand Sessions Clipboard functionality

The OnDemand Sessions feature a simple text Clipboard functionality,
which is achieved by synchronizing the clipboard between the Agent and
the Client devices. The toolbar, right-click Copy/Paste, and the following

key combinations are available for technicians to copy and paste the

content:
Client Agent  Keycombinations Toolbar available

macOS Windows CTRL-V no
CTRL-V yes

CMD-V no

WIN-V yes

CMD-C no

WIN-C yes

CTRL-C no

CTRL-C yes

right click - Copy no

right click - Paste no

Windows macOS CTRL-V no
CTRL-V yes

WIN-V no

CMD-V yes

WIN-C no
CMD-C yes

CTRL-C no
CTRL-C yes

right click - Copy no

right click - Paste no

NOTE: The Clipboard functionality works between Windows and macOS
Agent and Client devices.

The Clipboard functionality works on the following web browsers: Chrome,

Firefox, and Safari.
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NOTE: Due to the latest security and privacy implementations made by
Apple, Safari does not allow to copy and paste content between the Agent
and Client devices, without permission from the user.

To synchronize the clipboard between the Client and Agent devices,

press on the following button:

NE IS/

THANK YOU FOR DOWNLOADING
NETOP AGENT

Edit Tags |
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3.2.5 Start an OnDemand Session application on a macOS
machine

Prerequisite:

e The OnDemand application installed on your macOS device

To install the OnDemand application on your macOS device, proceed as
follows:
1. To install the OnDemand application, click on the link you received from

your technical support provider. The Session window is displayed.

NEIOP

ONDEMAND SESSION

Metop allows a support technician to remotely access and control a device.

Before a connection can be made, you need to download the Netop module on

your device.
Click below to download and execute the Netop module on your device.

Please note that once the software is connected, this device will be reachable
remotely by a support technician, so make sure you have received this link from a

trustworthy source.

B 1 understand

Session key 840660015

Download for macOS ‘ v

Do you already have Netop Agent installed on your Mac?

Click here to open it

Looking for OnDemand for iPhone? Scan the QR below.

2. Click on the "I Understand” button to allow the download.
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3. Download the Netop Agent.pkg file.

4. Execute the Netop Agent.pkg file on your macOS device. The
OnDemand Installer window is displayed.

5. Click on the Continue button to continue with the installation process.

6. Click on the Continue button to accept the License Agreement.

7. Click on the Install button to install the OnDemand application.

To use the Netop Agent on a macOS device, it is necessary that the

following permissions are manually granted by the user.

These permissions require to be set only once.

e Screen Recording (applies for macOS 10.15 and above)

e Accessibility (applies for macOS 10.14 and above)

Without these permissions, the Netop Agent Desktop functionality can

be restricted to:

¢ Viewing the desktop background, but no other applications
¢ Not being able to control the keyboard and mouse remotely
3.2.5.1 Screen Recording

Netop Agent Desktop requires Screen Recording access so remote users

can view your screen during remote control sessions.

The first time you open the application on your device, you are prompted

by the application to allow the Screen Recording permission.
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To grant the permission, proceed as follows:

1. Click on the Grant permission button.

Netop Agent requires Screen Recording access . ¢ 55 Security & Privacy
so remote users can view your screen during

remote control sessions, Gewwl | FBVIR  Frwss  Preacy

1. Click Grant Permissions to open the Security ; [— e S
& Privacy window. '

‘ SpaRch Racmgriter

-] e~
2. Click on the lock button from the bottom left g
side of the window and confirm your system
credentials.

3. Make sure that NetopAgentDesktop is
ticked.

4. Click on Quit & Reopen for the application to
use the permission.

2. Open System Preferences when the Screen Recording dialog appears

on the screen.

“NetopAgentDesktop.app” would like to control
this computer using accessibility features.

Grant access to this application in Security & Privacy
preferences, located in System Preferences.

Open System Preferences Deny

3. Click on the lock to make changes.

64



Netop Portal User’s Guide

4, Select the NetopAgentDesktop checkbox to grant the Screen
Recording permission.
& £ i Securily & Privacy &)

Goreral | FieVauk  Frewsll  Prvacy

Aliow The apps betow bo record ihe conienks of
W
l lemphane ¥OUF SrTean, geen whils usng othar appe

i Spasch Bscognition

ez bty

NPt MIedioeing

] # F A Dt

=yl sk Accesy

Fras and Foldars

I
Wlecis & ADple BT
ﬂ sinrma i

B Ciick the lock b pravent fur . Adwanced 7
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5. NetopAgentDesktop requires to quit and reopen to use the

permission. Click on the Quit & Reopen button to restart the application.

“NetopAgentDesktop.app” will be able to
record the contents of your screen until it is
quit.

You can choose to quit "NetopAgentDesktop.app”
now, or do it on your own later.

Later Quit Now

]
vncagent

| bash
N =
©> NetopAgentDesktop.app

1Tl NoMachine.app

Advanced...

6. Click on Next.

All permissions granted

Next +
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3.2.5.2 Accessibility

Netop Agent Desktop requires Accessibility access so your mouse and

keyboard can be controlled remotely.
Once you granted the Screen Recording permission, the application

prompts you to allow the Accessibility permission.

To grant the permission, proceed as follows:

1. Click on the Grant permission button.

Netop Agent requires Accessibility access so . < S5 Security & Privecy

your mouse and keyboard can be controlled

remotely, sl | PV | Fovesl Proacy

1. Click Grant Permission to open the Security & ; P Wb e e 1y o e Cormgae

Privacy window.
8§ resrgeinasy
2. Click on the lock button from the bottom left
side of the window and confirm your system
credentials.

3. Make sure that NetopAgentDesktop is
ticked.

Grant permission s o o
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2. Open System Preferences when the Accessibility dialog appears on

the screen.

“NetopAgentDesktop.app” would like to control
this computer using accessibility features.

Grant access to this application in Security & Privacy
preferences, located in System Preferences.

Open System Preferences Deny

3. Click on the lock to make changes.
4. Select the NetopAgentDesktop checkbox to grant the Accessibility

permission.

L < it Security & Privacy Q

General FileVault Firewall Privacy

Allow the apps below to control your computer.

1...: Microphone

.||||. Speech Recognition @ ImperoAgentDesktop

@ Accessibility

Full Disk Access

Files and Folders

@ Screen Recording
Media & Apple Music

g HomeKit

I 2
E Click the lock to prevent further changes. Advanced...
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5. Click on Next.

©

All permissions granted

Next +

To start the OnDemand session, proceed as follows:

1. Open the OnDemand application.
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2. Specify the session key you received from your technical support

provider.

Welcome to Netop

Please insert the session key you have received to connect:

Wait for the technician to start the OnDemand session from the Portal.

®Waiting for assistance...

Disconnect
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3. Once the technician starts the OnDemand session from the Portal, you
are prompted to allow the technician permissions for View remote

screen and Use keyboard & mouse.

Elvis Riza would like to connect to your device. Do
you want to allow the technician to connect?

The technician will be able to:

View remote screen

-— Use keyboard and mouse

4, Click on the Allow button to start the OnDemand session.

@ Safari File Edit View History Bookmarks Develop Window Help > @ | <O Thui048 Q =

[ ] < m -~ 0 @ get.alpha.connect.backdrop.cloud

NE PP

ONDEMAND SESSION

Download for macos @ v

Do you already have Netop Agent installed on your Mac?

Looking for OnDemand for iPhone? Scan the QR below.

qo m- e EReA ¥
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3.2.6 Start an OnDemand Session application on an iOS
device

With OnDemand for iOS you can view iOS devices screens and allow
technicians to offer remote support.
Prerequisite:

e The OnDemand application installed on your iOS device

There are three ways to download the OnDemand application on your iOS

device:

e From the AppStore
e From the link that you received from your technician
e By scanning the QR code from the download page

Looking for OnDemand for iPhone? Scan the QR below.

NOTE: If the OnDemand application is installed on your iOS device
when you scan the QR code from the download page, the OnDemand
app opens on your iOS device with the session key prefilled and ready
for connection.
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To start an OnDemand session, proceed as follows:

1. Open the OnDemand application on your iOS device.

2. Specify the session key that you received from your technician.

Initiate connection

lll-'l'i&n

Initiate connection

Connect with a technician on the Netop Portal
to troubleshoot your iOS device.

Portal available at:
connect.backdrop.cloud

Session key
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3. Click on the Initiate Connection button to initiate the OnDemand

session.

Initiate connection

J
nNIET @.)\'I'\

Initiate connection

Connect with a technician on the Netop Portal
to troubleshoot your iOS device.

Portal available at:
connect.backdrop.cloud

Session key

123456789
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You connected successfully to the OnDemand session. Wait for the

technician to start the OnDemand session from the Portal.

Waiting for a technician

MNET. @\'n

Waiting for a technician to
connect to your device
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4. Select one of the following remote control options to allow the

technician to connect to your iOS device:

e Start broadcast and Audio — starts the OnDemand session with
screen sharing and audio enabled

e Start broadcast — starts with the OnDemand session only with the
screen sharing enabled

e Start audio — starts the OnDemand session only with the audio
feature enabled

e Cancel — cancels the OnDemand remote control session

Allow remote support?

Would you like to allow Dragos Bantu
to support your mobile device?

You can choose to start any of the
following options. Tap on cancel to

disconnect from the session.
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5. Click on the Start Broadcast button to start broadcasting your screen.

The broadcast screen is displayed.

Netop OnDemand

Start Broadcast

The following window is displayed on the technicians’ monitor until you

start broadcasting your screen.

i

Screen sharing not active

You successfully connected ta the remote mobile device,
but screen sharing is nat yet active.

To share their screen, ask the remote user to do the following steps:

= tap the Screen Share button in the OnDemand app
= onthe broadcast screen, tap the Start Broadcast button to
start screen sharing
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If you close this window, you are redirected to the following page:

Connected
£

L II'T(‘®\1H

Share Screen and Audio Chat

The technician can now see your screen and
hear you.

R

Unmute Bluetooth

Screen Share Stop Audio

I—

6. You successfully started the OnDemand session.

NOTE: OnDemand for iOS offers a view-only mode of the iOS device
screen.
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To make an audio chat request, click or tap on the Start Audio button.

Connected

NETAD

Share Screen

The technician can now see your screen

You can stop the broadcast anytime or start
an Audio Chat.

m
[ ——
Start Audio

Screen Share S i

On the first use of the Audio Chat feature, you need to allow in the

browser for the microphone to be used. A popup is displayed in the browser
that requests the Technician to Allow or Deny the use of the microphone.

To allow the microphone use, click on the Allow button in the popup.
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e For Chrome

c O # remote.netop.com/ondemand/425308715
X
remote.netop.com wants to

& Use your microphone

Allow

425308715

You successfully connected to the remote mobile device, but screen

ﬁ sharing is not yet active.

e For Firefox

c Q D a? ttps://remote.netop.com/ondeman

Will you allow remote.netop.com to use your
microphone?

Microphone to share:

Microphone (Realtek High Definition Audia)

] Remember this decision

Don't Allow

Do you want to accept the audio chat request from the remote user?

Please allow access to your computer's microphone. You will still be
able to accept the chat if access is not allowed, but the remote user
will not be able to hear you.
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To allow the microphone to be used in the browser, proceed as follows:

e For Chrome
Open the Chrome internet browser.

In the search address bar, type in portal.netop.com.

Click on the “View Site Information” button (the lock icon in the search
bar).

# -onnect.backdrop.cloud

connect.backdrop.cloud

& Connection is secure

Motifications

Reset permission

@ Cookies

Site settings

4. Click on Site settings.

# connect.backdrop.cloud

connect.backdrop.cloud

& Connection is secure
Motifications

Reset permission

Cookies

Site settings
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5. Click on the dropdown button corresponding to Microphone.

Settings

You and Google & connect.backdrop.cloud
Autofill

Safety check
No usage data

Appearance
Search engine
Location Ask (default)

Default browser
Camera Ask (default)
On startup
Microphone Ask (default)
Advanced . Ask (defauh)

Allow

Motion sensors Block

Extensions
Notifications Ask (default)
About Chrome

JavaSeript Allow (default)
Images Allow (default)
Pop-ups and redirects Allow (default)

Ads
Block (default)

6. To enable the Microphone use, select the Allow option.

Settings

You and Google & connect.backdrop.cloud
Autofill

Safety check
No usage data
Pri

Appearance Reset permission

Search engine

Location Ask (default)
Default browser

Camera Ask (default)
On startup

Microphone Ask (default)
Advanced v Ask (default)

Allow
BiocK

Motion sensors
Extensions

Notifications Ask (default)
About Chrome

JavaScript Allow (default)

Images Allow (default)

Pop-ups and redirects Allow (default)

Ads
Block (default)
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2.

3

For Firefox
Open the Firefox internet browser.

In the search address bar, type in portal.netop.com.

Click on the lock icon.

< @, Q1818 portal.netop.com

Site information for portal.netop.com

B Connection secure

Clear cookies and site data...

M Dashboard

4. Click on the arrow button.

<« C O 8 & portal.netop.com

Site information for pertal.netop.com

B Connection secure

Clear cookies and site data...

A Dashboard

5. Click on the More information button.

&« C O B & portal.netop.com

< Connection security for portal.netop.com

B You are securely connected to this site.

Werificat de: Amazon

Netop Portal User’s Guide

‘ Dashboard More information
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6. Click on the Permissions icon.
@ Page Info — hitps://portal.netop.com/ = a et

i} E $Z a2

ﬁenéral Media JPermissionsl| Security

Web Site Identity
Web site:  portal.netop.com

Cwner: This web site does not supply ownership information.

Verified by: Amazon View Certificate
Privacy & History

Have | visited this web site before today? No

Is this web site storing information on my computer?  Yes, cookies and 229 kB of site data ~ Clear Cookies and Site Data

Have | saved any passwords for this web site? No View Saved Passwords

Technical Details
Connection Encrypted (TLS_AES_128_GCM_5HAZ256, 128 bit keys, TLS 1.3)

The page you are viewing was encrypted before being transmitted owver the Internet.

Encryption makes it difficult for unauthonsed people to view information travelling between computers. It is therefore
unlikely that anyone read this page as it travelled across the network,

This web site complies with the Certificate Transparency policy.

Help
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o B 1t 2

General Media Permissions  Security

Permissions for: https://portal.netop.com

Netop Portal User’s Guide

7. Uncheck the “Use default” option for the Use Microphone permission.

= O x

Usze Default

Send notifications

Usze Default

Set cookies
Use Default

Share the screen

Use Default

Store data in persistent storage

Allow for Session Elock

Always Ask Block

Allow Block

Always Ask Block

Use Default Allow Block

Switch to this tab

Use Default Always Ask Allow

Use the camera

Uze Default Allow Block

Use the microphone

Uze Default Allow Block
Help
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8. To enable the Use the Microphone

option.

Netop Portal User’s Guide

permission, select the Allow

@& Page Info — https://portal.netop.com/ — O
5 v ial
(i) |t &
General Media Permissions  Security
Permissions for: https://portal.netop.com
Use Default Always Ask Block
Send notifications
Use Default Always Ask Allow Block
Set cookies
Use Default Allow Allow for Session Block
Share the screen
Use Default Alvways Ask Block
Store data in persistent storage
Use Default Always Ask Allow Block
Switch to this tab
Use Default Always Ask Allow
Use the camera
Use Default Always Ask Allow Block
Use the microphone
[ ] Use Default () Always Ask | @) Allow | Block
Help
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e For Safari
When a user initiates the audio chat feature, the Safari browser displays a
pop-up notification that requires you to allow or deny Microphone use.

Click on the Allow button, to use the Microphone.

. K DI e

© »vo e e [ P E——, R R L oy —

Alternatively, to manually allow the use of the Microphone, proceed as
follows:

1. Open the Safari Internet browser.

2. In the address bar, specify portal .netop. com.

3. Click on Safari.
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4, Go to Preferences.

@ Safari File Edit View History Bookmarks Develop Window Help m & <> A~ Thu26Jun 1057 Q @ =
About Safari
Safari Extensions...

Preferences... ®, % MY ONDEMAND SESSIONS 0 @
Settings for This Website...

& portal.netop.com

Clear Histor

Services

Hide Safari All OnDemand Sessions () 9O Create session

Hide Others

@ Results can be filtered using the T on each column

o Waiting for

& My devices

MANAGE

482 Users

& Devices

L3 Groups

@ Applications

¥ Roles

2» Role assignments

Downloads

cEFIDITY

%G° MY ONDEMAND SESSIONS

A Dashboard

r Algw wETHIEE 1 MO TN MRPEAONG W T MG bk

) convect Sachdrop cloud

& My devices

& Users

& Devices

L3 Groups

@ Applications

WRas vAting e sl utey
® Roles

a» Role assignments

® Downloads
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6. Click on Microphone.

NETE&P

A Dashboard

U ‘ ASpw wETHUE 10 MU0 HAE TN MICRRAONG WM T MU ke
Contart Bockeny

acect Backanog cloud - B

@ My devices ¢ &% 2565
MANAGE oL
2
& Users I B, uoreners
& Devices ey
L3 Groups
@ Applications

N0 9 W Wose vioting et metetes: 20 @

®© Roles

a» Role assignments

® Downloads

7. Click on the dropdown button near the portal.netop.com
address.

A Dashboard

- Aoow welites 10 BCORSE 1ha MCrophone with the seflngs bebow
L) Comternt trochen
' My sessions
A -
() conract bact g ciond Ak e
[SRTHEITTC @0 e . wemEREEEEEEEEEE K—

& Usens
@ Devices Q Screen Sherng
L Groups

[ oewiss
@ Applcatons R aiaameta

Pod- up Wrdows When viliting cther mebiaiies. Asv B
® Roles

an Role sssgnments

® Downlosds

06 ddSOTERAMLC o
8. Select Allow.
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To stop the OnDemand session, proceed as follows:

1. Click on the Stop Broadcast button to stop broadcasting your screen.

NOTE: The OnDemand session is still available. To start broadcasting
your screen again, click on the Start Broadcast button.
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2. Click on the Close button to disconnect from the Portal. You receive a
prompt to confirm to disconnect from the OnDemand session.

09:40

Close

Share Screen

The technician can now see your screen.

You can stop the broadcast anytime or start
an Audio Chat,
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4, Click on the Stop Broadcast button to close the OnDemand client.

Connection ended

ANETAD

(©)

Connection Ended

The technician is no longer connected to
your device.

The OnDemand session has ended

Stop Broadcast

| Sopbroscas
——
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4 How to manage your account

The Portal provides a central place for managing users, devices, security

settings, role-based access, audit logs and a variety of options.

If the logged-in user has a Group Manager role or higher, a Manage and

Security areas in the sidebar menu are available.

P : "
NET4P % MY ONDEMAND SESSIONS S (! Mh&/\‘ i o iso

& Dashboard All OnDemand Sessions () A° Create session

[2] Results can be fitered using the ¥ on each column
%' My sessions
¥ Q wanater

& My devices

B My mobile devices

4 Users

& Devices

L3 Groups

@ Applications

W Roles

2s Role assignments

@ Downloads

This provides access to the management area. The homepage for the
management area is the Dashboard with various information including
devices and users, account information, activity information, and recent

updates.
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The expiration date from the Account info section turns red when the

account subscription is about to expire.

Account Owners are notified as follows:

e For regular accounts you are notified when there are 15 days or less
until the subscription expires

e For trial accounts you are notified when there are 7 days or less until the
subscription expires

@& Devices & Users I+ Activity

#* Account info (@ Recent updates

Timezone utc

® Documentation

NOTE: The user’s access varies within the management area based on the
user's role. Upon login to the Portal, Account Owners, Account
Administrators, and Group Managers are redirected to the Dashboard
page, while Regular Users are redirected to the My devices page.

4.1 Manage Users

The Portal allows you to centrally manage users within your organization.

This can be done by one or several users with administrative privileges.

The Portal interface provides easy access for managing the users.

There are four user types:

e User - view assigned devices and manage your profile

e Group manager — all the permissions of the User, plus the ability to
manage users and devices, view roles and role assignments, view and
generate log reports
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e Account administrator — manage users, devices, groups, roles and role
assignments, authentication methods, plus the ability to view account
details and manage deployment packages

e Account owner — all the permissions of the Account Administrator plus
the ability to manage the Account configuration

To view information about the users who have access to the Portal, on the

menu bar click on the Users tab. The list of users is displayed.

Refer to the Portal user privileges knowledge base article for the detailed

list of access privileges.

4.1.1 Create a new user

As a Group manager or higher, you have access to invite users to your

portal organization account via email.

To create a new user, proceed as follows:

1. Go to the Users tab.

2. Click on the Invite users button.
NET. ‘@\' D 208 USERS

~

2 Contact Netop Cg Purchase ) 1/5 1/2 43/50

/

# st Al Users
ACCESS

@ Results can be filtered using the T on each column

%" My sessions
& My devices

B My mobile devices

MANAGE
42t Users

& Devices

L3 Groups

@ Applications

¥ Roles

2s Role assignments

@ Downloads

95


https://support.netop.com/hc/en-us/articles/35669802398227-Netop-Portal-User-Privileges-EN

Netop Portal User’s Guide

The Invite users form is displayed.

3. Specify the email addresses of the users you want to invite to the Portal
account in the Email addresses entry field. You can specify it manually or
by copy and pasting a list of emails.

Invite users Users 4/10 X

To invite users, enter their email address:
Email address

Allusers will have "User" permissions

Send invite
Invite users Users 4/10 x
To invite users, enter their email address:
Email address I I
All users will have "User” permissions
Send invite

4. Click on the Advanced settings drop-down button to specify additional
information about the invited users. Note that the Advanced settings

apply to all invited users.

Al
Invite users Users 4/10 X
To invite users, enter their email address:
Email address |
All users will have "User" permissions
Send invite
d
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5. Select a User type for the invited users from the User type drop-down
field.

NOTE: By default, all users are assigned the “User” type.

Invite users Users 4/10 b4

To invite users, enter their email address:

Email address

All users will have "User" permissions

User type User

Read more on user types
Group (Optional

Default remote control action Control through browser

Enabled (This user is enabled)
( OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA disabled)

Send invite
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6. Optionally, you can select a group for the invited users from the Group

drop-down button.

Invite users Users 4/10 %

To invite users, enter their email address:
Email address

All users will have "User" permissions

User type User

Read more on user types
p

Group (Optional A4

Default remote control action 0 MNetRom

Enabled (This useris enabled)
( OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA disabled)

Send invite
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7. Select a default remote control action from the Default remote control

action drop-down field. By default, this option is the default setting on

the account.

Invite users Users 4/10

To invite users, enter their email address:

Email address

User type

Group (Optionz

Default remote control action

Enabled (This user is enable

OnDemand Sessions (Onle

User

Read more on user types

All users will have "User” permissions

Control through browser

Control through Guest

Control through browser

Multi-Factor Authentication (Email MFA disabled)

Send invite
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8. Enable or disable OnDemand Sessions for the invited users by clicking

on the toggle button. By default, this option is enabled.

Invite users Users 4/10 %

To invite users, enter their email address:

Email address

All users will have "User" permissions

User type User

Read more on user types
Group (Optiona

Default remote control action Control through browser

Enabled (This useris enabled)

( OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA disabled)

Send invite
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9. Enable or disable Multi-Factor Authentication by clicking on the

toggle button. By default, this option is disabled.

[

Invite users Users 4/10 X

To invite users, enter their email address:

Email address

All users will have "User" permissions

User type User

Read more on user types
Group (Optional
Default remote control action Control through browser v

Enabled (This user is enabled)

( OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA disabled)

Send invite
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10. To send the invitation, click on the Send invite button.

Invite users Users 4/10 X

To invite users, enter their email address:

Email address

£ Advanced settings v All users will have "User" permissions

User type User

Read more on user types here
Group (Optional)
Default remote control action Control through browser
Enabled (This useris enabled)

(.:ﬁl OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA disabled)

To resend the invitation email to users, simply select the invited users that

you want to resend the invitation email to and then click on the Resend
invite button.

202 USERS - Users:5/10 OnDemand users

The user has been invited. In case they don't see the email in their inbox, please advise them to also check the spam folder.

Devices 7 /50 Monica Nicolae W

b @ @ Gl Y &
L J

@ Results can be filtered using the ¥ on each column

Name T Status h g Type T Group A g Authentication method T Modified A a
@ Elvis Riza feriza@ativion.com) Online for about 1 hour Account Owner - INTERNAL 2025-06-05 11:29:23
O Maonica Nicolae (mnicolae@ativion.com) Last seen online: 2 days ago Account Administrator - INTERNAL 2025-05-16 10:54:04
@ Monica Nicolae (mricolse@netop.com) Online for about 52 minutes Account Administrator - INTERNAL 2025-06-04 13:2637
© NetRom Software (netop@netrom.ro) Last seen online: 1 day ago Account Administrator - INTERNAL 2025-05-22 08:53:53
@ user@gmailcom Invite pending User - INTERNAL 2025-06-05 12:26:31
Show Rows 10 w Gotopage 1 1-505 & >
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NOTE: The invitation email can be resent for a maximum of 5 times and is
valid for 7 days.

Invited users receive the invitation into the account via the specified email

addresses:

Join the team

You have been invited to join Netop
Connect Portal account. To accept the invite and create a user profile, click the
button below:

Accept invite

Your invite will expire in 7 days

After the users accept the invitation by clicking on the Accept invite
button, they are automatically redirected to the Set up your account

landing page.

| N | = @ EL,))\'I'\

Set up your user account

You have been invited by Dragos
Bantu to join Netop Remote Control

Please provide the necessary details to
create a user profile

Save & login
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To finish setting up the user account, click on the Save & login button.

NET4: P

Set up your user account

First name

John

Last name

Doe

Password

You have been invited by Dragos
Bantu to join Netop Remote Control

Please provide the necessary details to
createauserprofile | sesees

Save & login

4.1.2 LDAP users - automatically added into the Portal at
first login

This only applies if you are using LDAP authentication. On the first login

using the LDAP credentials (username: domain identifier\LDAP
username, password: the domain password), the user is added to the

Portal. The user type is User (more information on the user types here).

NOTE: The user is not attached to a group by default, but if there is a role
assignment in the Portal which allows all the users to access all the
devices (User: everyone, Devices: everything), the LDAP user has
access to all devices. Refer to the LDAP user groups sub-chapter to attach
the User to a Group on login.

4.1.3 Multiple accounts
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Users can belong to multiple Portal accounts when invited via email by an
Account Owner, Account Administrator, or Group Manager to a

secondary Portal account.
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Users that belong to multiple Portal accounts can switch between them.
They do so by clicking on the User Profile button and selecting the

secondary account that they want to switch to.

Account Owner s

Switch to

Other account

By default, the primary account is the account that the user was first
invited to. User settings are not transferred from the primary to any other
secondary accounts. As such users can have different permissions, roles,
or other settings on other secondary accounts without them interfering

with each other.

Users can set an account alias for the primary and secondary accounts.
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To set an account alias, proceed as follows:
1. Click on the User Profile button.
@ DASHBOARD 2 Contact Netop \(Epumhasa\ 5/10 5/10 7/50 :

(& Devices & Users I Activity

Devices Users

2. Click on the My Profile button.

MANET. b\' (») 22 USERS

2 ContactNetop | | = Purchase 115 12 43/50

A Dashboard :

ADCESS

All Users 1
%' My sessions

2| Results can be filtered using the ¥ on each columa
&3 My devices

-
-
-
-
-
-

B My mobile devices

38 Users

& Devices

L3 Groups

& Applications

® Roles

2» Role assignments

& Downloads

SECURITY

@ Account security

3. Click on the Set account alias button.

PROFILE 2 Contact Netop \\!FurchasE/\ Users: 24/ 50 OnDemand users:9/25 Devices:61/70

Monica Nicolae (mnicolae@netop.com) @ Change password Set account alias

Personal info

Username

First nam: Monica

Last name Nicol:

Email I top.
Default remote control action Control through browser

Account Membership

Account NetRom (Primary account)
Alias NetRom

Type Account Administrator
Multi-Factor Authentication Nene

OnDemand Sessions Ensbled

Account NETOP

4,
5. Specify an alias for the accounts in the Alias text input field.
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SET ACCOUNT ALIAS X
Account NetRom
Alias NetRom
Account NETOP
Alias NETOP
Save

6. To save your changes, click on the Save button.

SET ACCOUNT ALIAS X
Account NetRom
Alias NetRom
Account NETOP
Alias NETOP
Save

108



Netop Portal User’s Guide

4.1.4 View User Info

To view user information, in the Users list click on the desired username.

NET: '@)} D 202 USERS
A Dashboard

%" My sessions
& My devices Username

B My mobile devices

MANAGE Last name

Status

@ Applications

® Roles

2s Role assignments

@ Downloads

Username
Status

First Name

Last Name
Email

Group
Authentication
method

Multi-factor
authentication

Type

Specific information from the user’s profile is displayed.

R Contact Netop (!Pu:m;e) 1/5 1/2 43/50

P Check permissions 4 Edit

wwwwwwwww

A unique identifier used to log in.

Indicates whether the user is Online / Offline or if they

cannot log in to the Portal (Inactive), as well as the

period of time of the user while being Online/Offline.

e Online = User is logged in the Portal

o Offline = User is not logged in the Portal

e Inactive = User is disabled and cannot log in the
Portal.

User’s first name.

User’s last name.

The email address to which the user receives

notifications from the Portal and the multi-factor

authentication code if enabled.

The group the user belongs to.

Internal (username or password) or the name of the

authentication method defined under Account >

Authentication.

Indicates if multi-factor authentication is enabled for

the user or not.

Indicates the type of the account: Account Owner,
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Account Administrator, Group manager or User.
Sets up the default remote control action for the user.

Created The date and time when the user account was
Created.

Created by The first and last name of the user who created the
user account.

Modified The date and time when the user account was last
modified.

Modified by The first and last name of the user who last modified
the user account.

4.1.5 Edit the user

To edit an existing user, in the Users area click on the username of the

user you want to modify and in the upper right corner of the page click on
the Edit button. The Edit User window is displayed.
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Depending on the authentication method of the user, edit user is as

follows:

For Internal authentication, you can modify the following:

Basic profile information (such as First Name, Last Name, and Email)

Access permissions (toggle on or off the Active button and select the

user type to give specific access permissions within the Portal)

Select the groups the user belongs to and whether the user

authenticates using multi-factor authentication or not

Set up the default remote control action
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EDIT USER x
First name Monica

Last name Micolae

Email mnicolae@netop.com

Username mnicolae@netop.com (1]
Password (1]
Confirm password i ]
User type Account Administrator

Read more on user types here
Group (Optional)

Default remote control Control through browser (default for this account)
action

(j Enabled (This user is enabled)

(:I OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA disabled)
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NOTES.:

e If you toggle off the Active button, it disables the users so they can no
longer log in to the Portal. Disabling does NOT remove the user from
your Portal organization account.

e You are not allowed to edit the username.

e You are not allowed to edit a user whose role is higher than the user you
are logged in as.

e You are not allowed to change the role of an Account Owner from here.
Use the account configuration area instead.

o For ADFS / Azure AD based authentication. You can modify the role
(toggle on or off the Active button and select the user type to give
specific access permissions within the Portal), select the groups the user
belongs to and whether the user authenticates using multi-factor
authentication or not, or set up the default remote control action.

Once you have finished updating user information and access permissions,

click on the Save button to save the user updates.

4.1.6 Remove user

To remove an existing user, in the Users area, click on the username of the
user you want to remove and in the upper right corner of the page, click on

the Remove button.

232 USERS 2 ContactNetop | W Purchase

User details

NOTE: Only an Account Owner, Account Administrator or Group
Manager can remove users. The logged-in user can only remove users
with roles below their role.
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You can also remove an existing user, from the Users area by selecting the

desired user and above the content area click on the Remove button.

A confirmation dialog is displayed. To remove the selected user, click on

Yes.

NOTE: For users that belong to multiple accounts, when removing them
from their main Portal account, they are automatically removed from their
secondary accounts as well.

4.1.7 Remove multiple users

To remove multiple users at once, in the Users area, select the users you
want to remove and above the content area, click on the Remove button.
A confirmation dialog is displayed. To remove the selected users, click on

Yes.

202 USERS 2 Contact Netop ® Purcha: se

& Attach to group % Remove S5), Invite users

NOTE: If you remove an LDAP, ADFS or Azure AD user it does not mean
that the user is not able to log in again. On the next login, the user is
created again. To disable the user, edit the user and set the status to
inactive.
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4.1.8 Set up the default remote control action

In the Portal you can set up the default remote control action for each user

or for all the users that belong to the account.

To set up the default remote control action for a user, proceed as follows:
1. Go to the Users tab.

NETHD P S )

All Users S Invite users

& Attach to group # Edit - Check permissions ) Invite users

3. Click on the Edit button.
& Attach to group .3 Check permissions I8 Invite users

@ Results can be fitered using the ¥ on each column

oo
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4, Click on the Default remote control action drop-down menu.

EDIT USER %
First name Andrei
Last name Cucos
Email ancu(@netop.com
Username ancu@netop.com a
User type Account Administrator
Read more on user types here
Group (Optional) ioana new group X upgrade X

Default remote control I Control through browser (default for this account] ™ I
action

) - Control through Guest
( Enabled (This useri:

_ Control through browser (default for this account)
( OnDemand Sessio

( Multi-Factor Authentication (Email MFA enabled)

Save

5. Select fhe default remote control action.
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EDIT USER X
First name Andrei
Last name Cucos
Email ancu(@netop.com
Username ancu@netop.com a
User type Account Administrator
Res n y here
GrDup ioana new group X upgrade X

Default remote control Control through browser (default for this account] ™

action
Enabled (This user is enabled]
OnDemand Sessions (OnDemand Sessions are enabled for this user)

Multi-Factor Authentication (Email MFA enabled)

NOTE: An Account Owner can set up the default remote control action for
all the users in the account. For more information refer to Account
Configuration.

4.2 Manage Groups

The Portal allows you to group users and devices. Using these groups,

role-based access can be applied:

e Create a local user group and attach users to the group
e Add an LDAP group (LDAP authentication method required)
e Add Azure AD user groups from the Azure Portal (Azure AD

authentication method required)
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e Create a device group and attach devices to the group
e Add role assignment to define permissions for a user group when
connecting to a device group.

For more information refer to the Add role assignment sub-chapter.

4.2.1 Create a new group

To create a user group, proceed as follows:

1. From the Manage > Groups tab, click on the corresponding Add group
button to create a device group, an LDAP user group, Azure AD user
group, or a local user group.

2. Provide the group name and group description and select whether the
group is Active or not.

3. Click on the Save button. The group is successfully created.

4.2.2 Attach users to user groups

To attach users to a user group, proceed as follows:

1. Go to the Users tab, select the desired user(s).
2. Above the content area, click on the Attach to group button. A window s

displayed.

22 USERS £ Contact Netop W Purchase

3. Select the group to which the user(s) belongs.
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202 USERS 2 ContactNetop | ( ¥ Purchase )

B Attach to group 7 Edit A Check permissions S, Invite users

Netfom Software

4. Click on the Save button. The selected user(s) belong(s) now to this

user group as well.

ATTACH TO GROUP X

Group v

Save

[ A

NOTE: A user can be attached to multiple groups.

4.2.3 Add Azure AD user groups

Prerequisites:

e The Azure AD authentication method is correctly set up and
enabled. Refer to subchapter Enabling ADFS/Azure AD

authentication, for information on how to set up the Azure AD

authentication method.

To add Azure AD user groups to the Portal, proceed as follows:

1. From the Manage > Groups tab, click on the Add user group button.

QGROU"S 2 ContactNetop | ¥ Purchase

All groups Add device group T
] —— the ¥

119



Netop Portal User’s Guide

2. Select the Add Azure AD user group option from the dropdown field.
The Add Azure AD user group page is displayed.

o
;,L‘;'J GROUPS £ Contact Impero * Purchase sers: 27/ 50 Detmrard users: 8126 Devices: 47/ 70 w

- - S -

IS, Ad 3l user grow

£ Resuls can be fitered wsng the 'Y on each column

4_!~: Add LDAP user o
e I -
(&) Add Azure AD user greup |

@ )

3. Select the Azure AD authentication method from the dropdown
button.

Add Azure AD user group

Filter by name
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4. Select the user groups you want to add. Previously added groups are

marked in gray.

Add Azure AD user group

‘ Azure AD authentication method

Filter by name.

O Azure Test

Use the , Filter by name entry” field to quickly find the Azure AD user
group that you want.

Add Azure AD user group

I Filter by name.

O Azure Test
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5. Click on the Save button to save your changes.

Add Azure AD user group

O Azure Test

On every user login, the group membership is verified. If the user belongs
to any of the Azure AD user groups that were added to the Portal, the

group membership is also updated in the Portal.

4.2.4 LDAP user groups

To keep the same group membership in the Portal as you have in your
LDAP directory, add (import) the corresponding LDAP groups.

Every time a new employee comes and needs to be added to one of the
groups, or an employee leaves the company or changes groups, the user
can be managed (added/removed/disabled) directly in the company’s
LDAP directory (instead of having to manage the user in both the LDAP
and the Portal).

To achieve this, proceed as follows:

1. Add the LDAP authentication.
2. Add LDAP user groups.

By adding an LDAP user group, a special group is created in the Portal
with the same name as in the LDAP directory.
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This special type of group works as follows:

No users can be manually attached to the group

The only way the users are associated with the group is to add them in
the LDAP directory and on the next login of the user, that is
automatically synced with the Portal

The only things that can be edited/changed in the group are the status

(active/inactive) and the description

To add an LDAP group in the Portal, proceed as follows:

L.
2.

Go to Manage > Groups tab.

In the upper-right corner of the page click on the Add user group
button.

Select the Add LDAP user group option from the drop-down field. The
Add LDAP user group page is displayed.

From the drop-down select the LDAP authentication method from
which groups are imported. The drop-down lists all the LDAP
authentication methods you added from the Account > Authentication
tab. For information on how to add an LDAP authentication method,

refer to the Enable LDAP authentication sub-chapter.

Select the user groups to import. The groups that were imported in the
Portal are marked in gray.
To import the selected group in the Portal, click on the Save button.

The users are not synchronized at this stage.
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NOTE: You can attach an LDAP user to the Portal groups. A user
cannot be attached to an LDAP group.

ADD LDAP USER GROUP X

LDAP authentication method LDAP authentication method v ‘ e

Note

On every use login, the group membership is verified. If the user belongs to
any of the LDAP groups added to the Portal, the group membership is also
updated in the Portal. The name and email are synchronized on the user

login.

All Users ¢ 55, Invite users.

Username johndoe

irst name John

Last name Doe

Authentication method

OnDemand Sessions
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4.2,5 Attach devices to device groups

To attach devices to a device group, proceed as follows:

1. Go to the Devices tab, select the desired device(s).

2. Above the content area, click on the Attach to group button. The
Attach to Group window is displayed.

3. Select the group to which the device(s) belongs.

4. Click on the Save button. The selected device(s) belong now to this

device group as well.

ATTACH TO GROUP X

Group

Save

NOTE: You can attach a device to groups by editing the device and
specifying the corresponding device groups.
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4.2.6 View group details

To view the details of a user group, go to the Groups tab and click on the

desired group in the Name column. The group details are displayed.

L3 GROUPS SN (= Purchase )
N /

All groups Add user group % Add device group C[
El Results can be filtered using the ¥ on each column
4 Name v

From the user group details page, you can:

e View the users/devices who belong to the group

e Edit group details, such as the group name, group status and
description (LDAP group allow editing of status and description only)

e Remove the group

GROUPS 2 Contact Netop \(H Pumhasal 5/10 5/10 7/50

NetRom # Edit % Remove

52 Group details

Name N

Statu

Description

Type

Authentication method

Users

Created 2025-05-23 06:39:48

Created by

Modified 2025-05-23 06:39:48

Modified by
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4.2.7 Edit Groups

To edit group details, go to the Manage > Groups tab, and click on the
specific Group.

Above the content area click on the Edit button. The Edit Group window is

displayed.
N 1
EDIT USER GROUP x
Group name [\J&B&Qj &
Active
w
Users N4
Description

Save

4
Change the group details, such as the group name, group status or

description and click on the Save button.

NOTE: For LDAP groups you can only change the description and the
status. If you toggle off the Active button, it disables the group so that role
assignments no longer apply. Disabling does NOT remove the group.

4.2.8 Remove groups

To remove a group, proceed as follows:
1. Go to the specific group in the Manage > Groups tab.
2. Above the content area, click on the Remove button. A confirmation
window is displayed.
3. Clickon Yes.
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NOTE: By removing the group, the users/devices which are members of
that specific group are not removed.
4.3 Manage Devices

Once a device is configured with the Portal profile and is online, it is

automatically displayed in the Portal interface, Devices section and My

devices tab.

<1 Download Guest (Support Console) » Add device ¥

T Remote control =

@ Remote control -

To easily manage your devices, the My devices tab contains information
such as the hostname, the online availability of the device, device alias,

group of belonging, and the user.

In the Manage > Devices tab you can select the columns you want to

view.

To modify the column view, proceed as follows:

1. Go to the Manage > Devices tab.

2. From the top-right corner of the screen, click on the Choose columns
button.

128



Netop Portal User’s Guide

3. Select the columns you want to view or hide. The changes that you

make have an immediate effect.

O DEVICES

All Devices )

[2] Results can befittered using the ¥ on each column

.

wea A @ Online for about 14 hours

fag=] b O Last seen online: 2 days ago

el =] .. & O Lastseenonline: 16 days ago

wea - O Last seen online: 9 days ago

wea = O Last seen online: 13 days ago

w2 A ® Online for about 46 minutes

pag =} = O Last seen online: 9 days ago

= =

43.1 Edit devices

localhost localdomain

Netrom

NetRoms-Mac-mini-3.local

NetRoms-Mac-mini-3.local

NETVM-48PS56

netvm-48ps57

WS-169-021

-

temen

-

To edit a device, proceed as follows:

1. Go to the Manage > Devices tab.

2. Select the specific device.
3. Click on the Edit button.

5/10

( )
( )
13,05 (2025119)
( )

1305
13.05 (2025143)

1305

-

8 8 8
E E E
E § &
B B B

ENROLLED

ENROLLED

ENROLLED

ENROLLED

Show Rows

5/10 7/50

-

0~ Gotopage 1 1707 ¢ >

You can also edit the device by selecting the device and click on the Edit

button on the top-right menu.

Setting __ Descripton

name that could help supporters and

Alias An

internal
administrators to identify faster the device.

Group The Device group(s) that the device is attached to. A device
can be attached to any number of device groups.

Description An extended description for the device.
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EDIT DEVICE X
Change the details for the device below

Alias localhost localdomain

Group “

Description

Save

4.3.2 Remove devices

To remove devices, go to the Devices area, select the devices you want
to remove and above the content area click on the Remove button. A
confirmation dialog is displayed. To remove the selected devices from the
Portal, click on Yes. This is useful for devices that are not online anymore
(e.q., devices that are not used any longer or that do not have a Host
installed). For the devices that have a Host installed on them and are
connected to the Portal, they are re-enrolled on the next Host restart

(they show up again in the device list).

Refer to the Revoke deployment packages sub-chapter for more

information on how to disable devices associated with a deployment

package.

NOTE: Make sure that you have an Account Administrator user type or
higher to remove a device.
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4.3.3 Favorite Devices

With the Portal, you can add devices to favorites. Favorite devices are

displayed first in the list in the Devices tab.

NOTE: This feature is only available when using the new Connection
Manager. The Connection Manager serves as a meeting hub for Guests
and Hosts and is responsible for managing the connections between
modules.

To add a device to favorite, proceed as follows:

1. Go to the Devices tab.

2. Select the device you want to add to favorite.

3. Click on the “"Add to favorites” button, which is found in the top-right of

the screen.
I DEVICES £ Contact Netop 5/10 5/10 7150
& Attach to group # Edit % Remove B Check permissions % Add to favorites
[2] Resuits can be filtered using the ¥ on each column
4 Hostame v v v v v v v v
Online for about 14 hours - localhost.localdomain - 13.05 (2025153) ENROLLED
4 2 A O Last seen online: 2 days ago - Netrom - 13.05 (2025143) ENROLLED
f

Alternatively, through the Portal you can add a device or multiple devices

to favorite as follows:

e Click on the blue star near the device Hostname in the Devices tab;
favorite devices display a filled blue star near the device Hostname

e Select the device or multiple devices with the check button in the

Devices tab and click on the “"Add to favorites” button

E2 DEVICES 2 Contact Netop 5/10 5/10 7/50

All Devices (7

Results can be filtered using the T on each column

4 Hostname A A

-«
-«
-«
-
-«
-«

= A Online for about 14 hours - tocalhost localdomain - 13.05 (2025153) ENROLLED
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To remove a device from favorite, proceed as follows:

1. Go to the Devices tab.
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2. Select the device you want to remove from favorite.
3. Click on the Remove from favorites button, which is found in the top-

right of the screen.

E DEVICES QCOMNEIDD I(E Pumhasal 5/10 5/10 7150
& Attach to group # Edit * Remove B Check permissions ¢ Remove from favorites
@ Results can be filtered using the ¥ on each column

4 Hostname v

-«
-«
-
-«
-«
-«
-«

oo

(=] A Online for about 14 hours - localhost localdomain - 1305 (2025153) ENROLLED

Alternatively, through the Portal you can remove a device or multiple

devices from favorite as follows:

e Click on the blue star near the device Hostname in the Devices tab;
removed devices display an empty blue star near the device Hostname

e Select the device or multiple devices with the check button in the

Devices tab and click on the Remove from favorites button

&3 DEVICES £ Contact Netop \(! Purchasaw 5/10 5/10 7/50
= Attach to group # Edit x Remove #- Check permissions 7 Remove from favorites
\EI Results can be filtered using the ¥ on each column

»
-
“
«
-
-«
-

4.3.4 My Mobile Devices

To add mobile devices to the Portal, open the email received from Netop
with your myCloud account information. Activate your account by using

the link received in the email and set up a password.

In the Chrome Internet browser, add the WiseMo Guest for myCloud

extension from the Chrome Web Store link.
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To add a Host on your mobile device, proceed as follows:

1. Download the WiseMo Host App from the App/Play Store on your mobile
device. Depending on the manufacturer of your mobile device, it might be
necessary for you to install an extra add-on to allow remote desktop
features on your mobile device.

2. Open the WiseMo Host app.

3. Grant permissions when asked by the WiseMo Host app.

4. Specify your myCloud credentials.

5. Restart the Host.

To access your mobile device(s) from the Portal, proceed as follows:

1. Log in the Portal.

2. Access the My mobile devices tab.

3. There are two ways that you can control your mobile device. Click on

the Remote control dropdown button and you can select between:

e Control through Chrome app (default action)
e Control through WiseMo Guest

If you directly click on the Remote control button, the Portal starts the

remote control session via the Chrome app, which is the default action.

NOTE: Refer to the article in the Knowledge Base for
more information about the supported mobile devices in the Portal.

4.3.5 Applications

With whitelisted applications, account administrators can restrict remote
control sessions to a single application (or list of applications) on the Host
device. This includes viewing the screen and using a keyboard and mouse

for those applications.
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To add an application, proceed as follows:

1. Click on the Add application button.

5) APPLICATIONS & Contact Netop f! Purchu-e\ 5/10 5/10 7/50

Al Applcations
El Results can be filtered using the ¥ on each column

oo 7] v

2. Fill in the required information.

3. Click on Save.

r

ADD APPLICATION X

Name | a@m

(} Enabled [ This application is enabled)

Path - for instance: C:\Program Files\My Application (Optional)
Executable name - for instance: notepad.exe

Description (Optional)

Save

L. o
Setting Descrptin

Name A name for the application

Path The path for the application, including system environment
variables (e.g., $windir%\system32)

Executable Executable name (e.g., notepad.exe)
name
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Setting | Descripton

Description Description of the application

NOTE: The role assignment automatically becomes disabled if the
applications set as part of whitelisted applications are disabled.

44 Roles and Role assighments

Roles are a set of permissions that can be applied to a group of users
through Role Assignments.

A role assignment is comprised of a role, a group of users, and a group of
devices. Create user groups (including LDAP and Azure AD user groups)

and device groups before adding new role assignments.

Add role assignment ©* X

Name

( Active (This role assignment is active)

Role
User group
Device group

Description (Optional)

These are used for defining the permissions for the users in the Portal and

remote accessing a device.

NOTE: The devices listed in the Portal under the My devices tab are only
the devices that the user is allowed to connect to (at least one Role
assignment needs to exist containing a User group with that User and a
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Device group with that Device). For a user to be allowed to create (and
use) OnDemand Sessions under the My sessions tab, create the role
assignments for that group with an OnDemand - role type.

4.4.1 View Predefined Roles

The page provides a listing of the available roles, their type, name, and a
short description.

Multiple role types have been implemented, each representing a specific
set of permissions:

e The Device role type includes a set of permissions related to remote
control sessions. By clicking on the name of a specific role from the
roles page, the user is provided information about the role and the full
list of associated permissions.

NOTE: When creating a Device role type, make sure to select the
corresponding client type for your Guest device.

e The OnDemand role type includes a set of permissions related to the
OnDemand Sessions. The permissions include keyboard and mouse
access and to view the remote screen.

e The Confirm access role type provides increased security through the
addition of a confirmation dialog on the Host side.

e The Whitelisted applications role type provides the capability to
restrict remote control sessions to a single application.

NOTE: Account Administrators, Owners and Group Managers can view
the Roles

Administrator Provides full access to the remote device when using
the Control through browser option or an installed
Guest.

Web Support Provides full access to the Control through browser
option. Access from an installed Guest is not allowed.

Full Access Provides full access to the remote device when using
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Predefined Description
Roles

(OnDemand the OnDemand Session. This role does not apply to
Sessions) regular Guests and Hosts.

Confirm Access Requires that the local user at a remote device to
Required confirm a session before it starts; except for when the

computer is locked, or no one is logged in.

4.4.2 How to add a role

To add a role, proceed as follows:

Go to the Roles tab.

Click on the Add button.

Specify a name for the role.

Select the role type from the drop-down list.

Enable or disable the role.

To save the changes made, click on the Save button.

ADD ROLE X

Name ‘ | ‘

Type ‘ ‘

Description (Optional)

( Enabled (This role is enabled)

4.4.3 How to edit a role

To edit a role, proceed as follows:

1. Go to the Roles tab.

2. Select a role to edit.

3. To edit the role, click on the Edit button.
4

In the Edit role dialog box, you can:
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e Edit the Role Name.

e Edit the Type from the drop-down list.
e Edit the description.

e Enable or disable the role.

o Edit additional Role type options

5. To save the changes made, click on the Save button.

EDIT ROLE X

The permissions will change following the role saving.

Mame Test Role

Type Device

Description (Optional

( Enabled (This role is enabled)

Remote session v
Tunnel v

Clent type v

Save

4.4.4 How to copy a role

To copy a role, proceed as follows:

1. Go to the Roles tab.

2. Select a role to copy.

Click on the Copy role button. The Add role dialog box is displayed.
Edit the name of the role you want to copy.

Edit the description of the role you want to copy.

Enable or disable the role.

N o v s~ W

Edit additional Role type options.
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8. To save the changes made, click on the Save button.

ADD ROLE X
Mame Copy of Test Role role
Type Device

Description (Optional

( Enabled (This role is enabled)

Remote session v
Tunnel v

Client type v

Save

4.4.5 How to remove a role

To remove a role, proceed as follows:

L.
2.

Go to the Roles tab.

Select the role you want to remove.

Click on the Remove button. The Remove Role dialog box for
confirmation is displayed.

To remove the role, click on Yes.

REMOVE ROLE X

Are you sure you want to remove the role?
The following & role assignments will be disabled:
test only, loana's CAVE RA, admin, cfacrgi, fa2, adb
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NOTE: If the user deletes a role which is part of an active role assignment,
the role assignment becomes disabled and the user receives a warning
about this.

4.4.6 Add role assignment

To add a role assignment, proceed as follows:

1. Go to the Role assignments tab and click on the Add role assignment
button.

2. Provide the role name and make sure that the assignment is enabled.

3. From the appropriate drop-down lists, select the role, user group, and
device group. Role assignments can be applied to multiple user and

device groups.

Add role assignment x Add role assignment X

MName Name
Active (This role assignment is active) Active (This role assignment is active)

Role Role
User group ‘ v User group

Device group O Everyone Device group | N
O adsads ~

Description Description O Everything

O cfacrgi
O aaa

O disiUsersGroup
O cfacrgi

0O driv
v O custom sandu ciorba mocks v

141



Netop Portal User’s Guide

4. To save your changes, click on the Save button.

Add role assignment . X

MName

Active (This role assignment is active)

Role
User group
Device group

Description (Optiona

NOTE: For a role assignment to govern the permissions of a remote user,
make sure that the Host’s Guest Access Security settings are configured
to use Portal access rights. Refer to the Netop User’s Guide for more
information on the Guest Access Security settings within the Host. For
the OnDemand - type roles, device groups cannot be selected, as these
role assignments do not apply to regular devices.

4.4.7 Edit role assignment

To edit a role assignment, proceed as follows:

1. Go to the Role assignments section, select the role assignment you
want to edit.

2. Above the content area click on the Edit button. The Edit Role
Assignment window is displayed.

3. Make the desired changes.
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4. To save your changes, click on the Save button.

Edit role assignment x

Make sure that users from the selected User group who are used on the Host do not b4
have Multi factor enabled.

G This role assignment is scheduled starting from Apnl 2, 2021, every day, full ime
[Europe/Bucharest time).

Mame adb

( Active (This role assignment is active)

Role Add Devices
User group Everyone X
Device group Everything X

Description (Optional)

Save

NOTE: Disabling the role assignment does not remove it from the Portal.
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4.4.8 Create a schedule for a role assignment

A schedule can be created for a role assignment. In the scheduler you can
specify the following information:
e Schedule interval

e Recurrence

v

© SCHEDULE FOR ADMIN Closex

o Schedule interval

i}

Start time End time ':] All day !
Europe Bucharest (GMT+03:00)

G Recurrence

No recurrence

No end date

NOTE: This feature is only available when using the new Connection
Manager. The Connection Manager serves as a meeting hub for Guests
and Hosts and is responsible for managing the connections between
modules.

In the Schedule interval you can specify the following information:

e Start date — you specify the day that the role assignment starts

e Start time — you specify the time when the role assignment starts

e End time — you specify the time when the role assignment becomes
inactive

e All day — you use this option to specify that the role assignment is valid
throughout the day; when you use this option, the Start date and the
Start time fields become inactive

e Timezone — you specify the Timezone for the role assignment
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In the Recurrence area, you specify the recurrence for the role

assignment.

The following options are available:

e NO recurrence
e daily

e weekly

e monthly

e yearly

G Recurrence

Daily

No recurrence
Daily

Weekly
Maonthly

Yearly

Recurrence Description

No Select this option to apply the schedule indefinitely.
recurrence
Daily You use this when you want the schedule to recur on

specific days or every X number of days.

Possible values:
e Only weekdays

e Only weekends
e Custom

Weekly Possible values:

e Every X week on
e Monday

e Tuesday

e Wednesday

e Thursday

145



Netop Portal User’s Guide

e Friday
e Saturday
e Sunday

Monthly

Possible values:

e Every X month on
e Day of the month
e Last day of the month

Yearly

Possible values:

e Every X year on
e Month of the year
e Day of the month

The Schedule status can be:

e Active
Status

e Inactive

Status

Vol aclive, due 1o schedule

To create a schedule for a role assignment, proceed as follows:

1. Inthe
2. Inthe

page, click on the

tab, click on the Role assignment you want

to assign a schedule to.

3. To add a schedule to the Role assignment, click on the
button.

2q ROLE ASSIGNMENTS

Administrator

& Contact Netop

=~
&)
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The window for the Role assignment is displayed.

Start time End time Oalday
Europe Bucharest (GMT+03:00)

G Recurrence

Mo recurrence

Mo end date

4. Specify the schedule interval:
4.1.Specify the Start date.
4.2.Specify the Start time.
4.3.Specify the End time.

NOTE: If you click on the Save button and you do not specify a Start
date, Start time, and End time, the Schedule applies starting on the
present day, for All day, full time.

5. Specify the recurrence for the schedule:
5.1.Specify the recurrence.
5.2.Specify the End date for the recurrence.

NOTE: If you do not specify a recurrence for the schedule, the schedule
applies until you manually remove it, or you add an end date to the
recurrence.
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6. To save your changes, click on the Save button.
4

© SCHEDULE FOR ADMIN Clasex

0 Schedule interval

Start time End time DFKU. day Timez
Europe Bucharest (GMT+03:00)

G Recurrence

No recurrence

No end date

NOTE: You can assign a schedule to multiple role assignments.

To edit a schedule for a role assignment, proceed as follows:

1. In the Portal page, click on the Role assignments tab.

2. Inthe Role assignments tab, click on the Role assignment you want to
assign a schedule to.

3. To edit a schedule of the Role assignment, click on the Change
Schedule button.

2 ROLE ASSIGNMENTS £ Contact Netop 5/10 5/10 8/50

Administrator # Edit © Change schedule % Remove schedule X Remove

4. Make the changes you want.

5. To save your changes, click on the Save button.
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To remove a schedule from a role assignment, proceed as follows:

1. Inthe Portal page, click on the Role assignments tab.

2. Inthe Role assignments tab, click on the Role assignment you want
to remove the schedule.

3. To remove the schedule of the Role assignment, click on the Remove
Schedule button.

2, ROLE ASSIGNMENTS £ Contact Netop 1/5 1/2 44/50
Administrator # Edit © Schedule

Ss Role assignment details

Status ® Enabled

Created by
Modified 2019-11-21 10:35:16

Modified by

The Remove Schedule for Assignment warning is displayed.

REMOVE SCHEDULE FOR ASSIGNMENT Closex

Are you sure you want to remove the schedule for the
role assignment?

4, Click on Yes to confirm.
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NOTE:
e You can remove a schedule from multiple role assignments.

e A schedule is removed if you delete the role assignment(s).

4.4.9 Remove role assignments

To remove role assignments, go to the Role assignments tab, select the
items you want to remove and above the content area click on the
Remove button. A confirmation dialogue is displayed. To remove the

selected role assignments, click on Yes.

4.4.10 Confirm Access role

Starting with Netop version 12.67 for Windows Hosts and 12.70 for Linux and
macOS Hosts, the Confirm access functionality was added, and starting
with version 12.82 for Windows Hosts the Confirm access via email
feature was introduced. The Confirm access feature provides improved
security by adding a confirmation dialog on the end-user side (Host
side).
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The Confirm access via email feature is configured along with a user
group. Once Confirm access via email is triggered, all the users in that
group receive an email requesting them to provide access to the Host. The
email contains a confirm access link, the name of the user requesting
access, and the name of the Host. Once the link in the email is clicked on,
you are redirected to the Portal where you can allow or deny access to the

device for the user that requested it.

CONFIRM ACCESS X

You are seeing this page because your user belongs to a role which has confirm access via email
enabled.

Whenever a user assigned to that role fries to access a device, a confirm access request such as
this will be issued and you will be asked to allow or deny access for that user.

Do you want to confirm access for the following connection?

Connection attempt details

User firstname lastname John Doe
Username
Host name DESKTOP

Connection attempt 2021-09-16 18:17:43

‘ e ‘

The access granted through the confirm access email is audited.

4.4.10.1 How to add a Confirm Access role

To create a Confirm Access role, proceed as follows:

1. Go to the Roles tab.

2. Click on the Add role button.

3. Specify a name for the role.

4. From the Type drop-down list, select the Confirm access type.

5. Enable or disable the role.

6. You can use either the Confirm access or Confirm access via email
option or both for the Confirm access role. To use the options, select the

Enable confirm access, respectively Enable confirm access via email
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checkboxes. If you use Confirm access via email you must add a user
group or multiple groups that receive an email when a user requests

access to a device.

ADD ROLE x

Please note that the Confirm Acocess via Email functionality works only on Hosts v12.82 or later. For older Hosts, the connection to them
will be denied if Confirm Access via Email is enabled in any of their role assignments.

Please note that the locked computer/logged in user constraints are only supported on Windows Hosts. For other Hosts, the confirm
access mechanism will always be triggered if enabled in any of their role assignments.

Mame Confirm Access
Type Confirm access

Description (Optional

( Enabled (This role is enabled)

Confirm access v

Confirm access via email v

User groups

Save

7. To save the changes made, click on the Save button.

NOTE: If both the Confirm access and Confirm access via email
features are enabled, whichever type of confirmation happens first, the
user is granted access to the Host.

4.4.10.2 How to add a Confirm access role assighment

To add the Confirm access role to a role assignment, proceed as follows:
1. Go to the Role assignments tab.

2. Click on the Add role assignments button.

3. Specify a name for the role assignment.

4. Activate the role assignment.

5. From the Role drop-down list, select the Confirm access role.
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6. Assign the role to a User group.

NOTE: When the Confirm access via email option is enabled, you
allow or deny access to a device for users that belong to this User

group.
7. Assign the role to a Device group.

NOTE: When the Confirm access via email option is enabled, you
allow or deny access to devices that belong to this Device group.

8. To save the changes made, click on the Save button.

Add role assignment

Mame Confirm Access

Active (This role assignment is active)

Role Confirm access (Administrator) o
User group Everyone X
Device group Everything X

Descrniption |

NOTE:

e The Confirm Access functionality works only on Hosts and Guests
v12.67 or later. For older Guests and Hosts, the connection between
them is denied if the Confirm Access feature is enabled in any of their
role assignments.

e The Confirm Access via email functionality works only on Guests and
Hosts version 12.82 or later. For older Guests and Hosts, the
connection between them is denied if the Confirm Access via email
feature is enabled in any of their role assignments.
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Once the Confirm access is defined, on the next remote session between the
Guest and Host, a confirm access prompt is displayed to the end-user on the

Host side.

There are two extra exceptions when the Confirm access and the
Confirm access via email can be set to be overruled even though it is

enabled.

For Confirm Access:

e Except when computer is locked - if the computer is in the locked
screen.

e Except when no user is logged in - if no user is logged into the

system.

Confirm Access

% 8 wants to access your PC.
You have the opportunity to
allow or deny the access.

Allow Deny

For Confirm access via email:

e Only when computer is locked
e Only when no user is logged in
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When confirmed, the remote session is initiated. If denied, the confirm

session is not initiated.

NOTE: The exceptions for Confirm Access and Confirm access via
email do not apply to the macOS and Linux Hosts.

44.11 Whitelisted applications role

Starting with Netop version 12.74 for Windows Hosts, the capability of
whitelisting applications is available. With whitelisted applications, users
can restrict remote control sessions to a single application (or list of
applications) on the Host device. This includes viewing the screen and

using the keyboard and mouse for those applications.

4.4.11.1 How to add a Whitelisted applications role

To create a whitelisted applications role, proceed as follows:

1. Go to the Roles tab.

2. Click on the Add role button.

3. Specify a name for the role.

4. From the Type drop-down list, select the Whitelisted applications
type.

5. Enable or disable the role.

6. Edit additional Whitelisted applications options.

7. Select the application(s) to be whitelisted.
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8. To save the changes, click on the Save button.

ADD ROLE 28
Name New Role
Type Whitelisted applications
Description (Opt
Enabled (This role is enabled)
Whitelisted applications A
Enable whitelisted applications
Except when computer is locked

Except when no user is logged in

<]

Whitelisted applications

4.4.11.2 How to add a Whitelisted applications role to a role
assignment

To add a whitelisted applications role to a role assignment, proceed as
follows:

1. Go to the Role assignments tab.

2. Click on the Add role assignment button.

3. Specify a name for the role assignment.

4. Activate or deactivate the role assignment.

5. From the Role drop-down list, select the whitelisted application's role.

6. Select the User group.

7. Select the Device group.
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8. To save the changes made, click on the Save button.

Add role assignment X

Mame
Active (This role assignment is active)
Role
User group
Device group

Description

Once the whitelisted applications are enabled, on the next remote session

between the Guest and Host, only these apps are visible to the user.
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There are two extra exceptions when the whitelisted application can be set

to be overruled even though it is enabled:

e Except when computer is locked - if the computer is in the locked
screen.

e Except when no user is logged in - if no user is logged into the

system.

In either of these exceptions, the whitelisting applications are not enabled

throughout the session.

NOTE: The role assignment automatically becomes disabled if all the
applications that are set as part of the whitelisted applications become
disabled.

For more information on whitelisted applications, refer to the following

knowledge base article.

44.12 Check permissions

To verify the permissions of a user on a certain device, use Check
permissions.
1. Click on the Check permissions button. It is available in different areas

of the Portal (Role assignments, Device view, User view).

John Doe P —

Remove

158


https://support.netop.com/hc/en-us/articles/35782502389395-Whitelisting-Applications-for-Netop-Portal

2. Select the User and the Device.

Netop Portal User’s Guide

CHECK PERMISSIONS

User John Doe

Device Select device to check permissions

Date Time Timezone
2022-04-07 (] 15:57 O

Europe/Bucharest v

Since permissions can change in time due to existing schedules applied

on the Role Assignments, you can specify a date to check for the

permissions.
4. Specify the time for the permissions.

5. Specify the Timezone for the permissions.
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6. To view the granted permissions, click on the Check permissions
button. This provides an overview of the exact permissions of the User
on the Device, plus an overview of the Role assignments that involve

both the User groups and the Device.

Granted permissions for user on device valid at 2022-04-07, 15:57 (Europe/Bucharest

. Remote control w
time) -

& User details

' Device details

Hostname o

& Permissions

Remote session

View remote screen

Use keyboard and mouse
Lock keyboard and mouse
Blank the screen

Transfer clipboard

= =
00606660,

Execute command

4.5 Downloads - using Deployment Packages

The deployment package represents a way of enrolling the devices into the
Portal. The deployment package describes among other things the interval in
which the Host can be installed, for how many installations or what

device group belongs to on enroliment.

Prerequisites for deployment packages:

e Windows Host running version 12.65 or later

e Linux & macOS Host version 12.75 or later

For versions earlier than the above, refer to the Role assignments sub-

chapter on how to enroll them.
The Manage > Downloads tab allows the management of deployment

packages.
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NOTE: Account administrators or higher can manage deployment

packages.

4.5.1 Create a deployment package

To create a deployment package, click on the Add deployment package

button in the upper-right corner of the Deployment Packages page. The

Add deployment package window is displayed.

Add deployment package
Deployment package details

Name
Valid from

Valid to (Optional)

Package status

( ) Enabled (This deployment package is enabled)

Number of devices

( Unlimited (Unlimited devices)

License key (optional - leave

using the online installer.

Description (Optional)

On enrollment

This license key will be applied only when installing the Host

Specify the deployment package details.

Seting—— Desarption

Name The name of the deployment package.

Description  Optional description of the deployment package.

Valid from The Host can be installed using this Enroliment key only
when starting with this date (the time is UTC based).

Valid to The Host can be installed using this Enroliment key only
before this date (the time is UTC based). If no date is
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selected, the enrollment key has no expiration date.

Number of The number of devices, which can be enrolled using this
devices Enroliment key.

Package Indicates whether the Enrollment key can be used or not.
status If disabled, new device enrollments do not work. Already
enrolled devices continue to work.

License key This is the license key that is applied to the Host. If empty,
the Host is set to Trial mode. If the Trial mode expired,
the Host converts to a Portal only mode, which allows only
the Portal communication profile (only works with a Portal
account).

Move to The group to which the device automatically belongs to on
device group enroliment.

Enroliment Specify if an administrator is required to review the status of

state the device (Pending) or not (Enrolled) before the device is
enrolled. Check Pending state for how to enroll pending
devices.

Once you've specified all the necessary details, click on the Save button.
The deployment package is created. Upon creation, a unique Enroliment

key and Online installers are generated.
| Y | = @ {@\’D @DDWNLOADS £ ContactNetop | ™ Purchase |

new test # Edit @ upload @ Revoke

Download installers

= Windows ~
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To view the enroliment key, from the Deployment packages list, click on

the name of the deployment package.

4.5.2 Download and install the Host using default
configuration

When a deployment package is created, an online installer is also

generated. The online installer uses a default configuration for setting up

the latest version of the Windows Host. When installing the Host using an

online installer, an available internet connection is necessary as the files

are retrieved from online. You can find offline installers for all the supported

platforms in the Deployment Package details page.

4.5.2.1 Download and install the Host using an Online installer (.exe
file)

To download and install the Host using the online installer, proceed as
follows:

1. Go to the Downloads tab.
2. Click on the deployment package that you want to install. The
Deployment package details page is displayed.
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3. Download the Online installer available in the Download installers

section.

LD DOWNLOADS £ ContactNetop | W Furchase
Trial Host # Edit @ Upload @ Revoke

Download installers

@ Windows ~

NOTE: Do not change the name of the online installer. Otherwise, the

deployment package installation is unsuccessful.

4. To install the deployment package, double-click on the downloaded
installer (admin rights are necessary on the device).

5. Read and accept the Netop License Agreement.

6. Click on the Next button.

The Host is installed and automatically configured to connect to the
associated Portal account. Further configurations are no longer necessary.
4.5.2.2 Share the Online installer link

1. If you would like to share a unique link with the online installer, click on
the Copy link button to copy it into the clipboard or click on the Send

link button to open your email client with the link.
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2. On the target device, the user can open the link. By clicking on I

understand, the user can download and install the Host.

Control this device

B |understand

Windows 7/8/10 = -

System requirements

For more information, click here

3. Users can download the Host for a different OS platform, by clicking on

the dropdown button near the Download button and click on the

respective OS button.

Control this device

| understand

Windows 7/8/10 5@

Windows XP / Vista =
macOS ‘
RedHat Enterprise 7.x / CentOS 7.x 1_’_\
Ubuntu 16.04 / 18.04 (64 bit) AR
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4, Install the online installer as described above.

4.5.3 Download and install online installer using a custom
Host configuration (Windows)

If you want to use a custom Host configuration, create the configuration

file (.MST file). Refer to the Pack'n’Deploy User’s Guide for information on

how to create custom Host configuration files using Netop.

Once you created the custom Host configuration file, go to the
deployment package details page and click on the Upload button. Upload
the .MSI and the .MST files.

UPLOAD CUSTOM HOST X

Upload new MSI file

Upload new MST file

F
t
(Uploaded on: 2020-04-24 18:11:10)

4

After uploading an .MSI or an .MST file, the date and time when the file
was uploaded are displayed under the corresponding upload buttons. This
allows you to easily identify if the deployment package contains a custom

Host configuration or if the default online installer is used for deployment.
On the next installation using the online installer, the custom files are used.

NOTE: To revert to the default files, create a new deployment package.
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4.5.4 Mass deploy the Host (Windows)

For instructions on how to mass deploy the Host on Windows, refer to the

Mass deploy Portal components knowledge base article.

4.5.5 Revoke deployment packages

You revoke the deployment packages by clicking on the Revoke button in

the upper-left corner of the Deployment package details page.

LD DOWNLOADS & Contact Netop 1/5 1/2 44/50

new test # Edit @ Upload @ Revoke

The Revoke Deployment Package warning prompt is displayed.

r N

REVOKE DEPLOYMENT PACKAGE? X

6 devices will stop working after revocation.
Warning: these currently enrolled devices will need to be re-
enrolled with a different enrollment key, in order to reconnect

them to the Portal

4

Specify “revoke” in the “"Type “revoke” to confirm” entry field to confirm.

Revoking deployment packages means that:

e You are no longer able to install devices using that enrollment package.

e Devices enrolled using the deployment package, can no longer connect
to the Portal; another enrollment key is necessary.

e Revoked devices are still displayed in the device list with a state name
Revoked.

The revoked deployment package is marked with a red sign: @
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To re-enroll these devices into the Portal, create another deployment
package and configure the Host on the devices to use the new enroliment

key.

4.5.6 Remove deployment packages

You can remove deployment packages by clicking on the Remove button

in the upper-left corner of the Deployment package details page.

# Edit @ Revoke % Remove 1D Add deployment package

@ Results can be filtered using the T on each column

# Name Y

-
-
-
1]

[ ] Enrolled 2024-11-20 - 10 Online installer =
[ ] Pending 2024-11-20 - o Online installer =

[ ] Enrolled 2019-11-21 - 34 Online installer ¥

+ Rows 10 w Gotopage 1 1-30f3 ¢ >

NOTE: You can only remove deployment packages that have no devices
associated or which are revoked.

4.5.7 Pending state

For devices in the Pending state, go to the Manage > Devices tab.

Identify the Pending device and enroll it by clicking on the Enroll button.

DESKTOP-3TGGLT7 m % Add to favorites M- Check permissions # Edit ¥ Remove
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5 Security

This section provides various options for overall account security.

5.1 Enable Multi-Factor authentication

The authentication can be configured to use two factors: the first
authentication factor is the username and password (something the user
knows), the second factor is a passcode received by email (something the

user has).

To manage the account security, administrator rights or higher are
necessary. You have the option to enable MFA per user or to enforce the
option to all users. When the Enforced option is selected, users cannot
modify the Multi-Factor authentication settings for themselves or other

USers.

To enable or enforce the multi-factor authentication, proceed as follows:
1. Go to Security > Account security area and click on the Edit button.
2. Click on the Multi-factor authentication dropdown field.

3. Select Enabled or Enforced.

4. Click on the Save button.

EDIT ACCOUNT SECURITY X

Multi-Factor Authentication Enabled (it can be enabled per user) v

Disabled
Logging Enabled (it can be enabled per user)

Enforced (it will be enabled for all users)

Once email-based multi-factor authentication is enabled for your account,
you can enable the use of multi-factor authentication on individual users.
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When editing users, you can now enable multi-factor authentication as
well.
Go to the Manage > Users tab, select the desired user and in the upper-

left corner of the page, click on the Edit button.

EDIT USER X

First name John

Last name Doe

Email

Username [ ]

User type Account Administrator

Group

Default remote control Control through browser
action

Enabled (This user is enabled)
OnDemand Sessions (OnDemand Sessions are enabled for this user)

( ) Multi-Factor Authentication (Email MFA disabled)

‘ Save J

Enable multi-factor authentication and clickon the Save button.

NOTE:

e User credentials are used to configure the communication profile on
both Guest and Host. For security reasons, we strongly recommend
creating dedicated users assigned to enroll devices in the Portal.

e If you enable multi-factor authentication for a user, make sure that those
user credentials are not used in the definition of the Guest or Host
communication profile (Portal communication device). If credentials
from a user with multi-factor authentication enabled are used, the
Guest or the Host are not able to make a connection to the Portal.

e Starting with Netop version 12.65 (on Windows 7 and later) and Netop
version 12.75 (Linux & macOS) enroliment keys are
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used for the Portal communication profile. Therefore, the above note
does not apply anymore.

5.2 Authentication

The Portal provides the following authentication methods:

e Internal (username & password saved in the Portal database)
e ADFS (Active Directory Federation Services)/Azure AD

e LDAP (Lightweight Directory Access Protocol)

5.2.1 LDAP authentication

With the integration to the Lightweight Directory Access Protocol (LDAP), the
Portal provides another way of integration into the company’s central user
directory. This enables administrators to manage the users and users’
permissions from only one place — the company’s user directory. The
integration with LDAP is done in such a manner that no passwords are

stored in the Portal — the credentials are checked on every login.

NOTE: Only account administrators or higher can manage Authentication.

5.2.1.1 Enabling LDAP authentication

To enable LDAP authentication, proceed as follows:

1. Go to the Security > Authentication tab.

2. In the upper-left corner of the page click on the Add LDAP button. The
Add LDAP authentication method page is displayed.

#A Dashboarc All authentication methods

3. Enable LDAP authentication.
4. Specify the information for setting up the LDAP connection.
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5. To save the authentication settings, click on the Save LDAP

authentication method button.

Group schema settings Additional Group DN

Group Search Filter - for instance:
(objectClass=group)

Group Browse Filter - for instance:
(I{objectClass=group)
(objectClass=organizationalUnit)

Group Attribute - for instance: group

Group members Attribute - for instance: member

Once you enable the LDAP authentication, you can import LDAP groups in

the create role assignments for each of the groups to associate with the

corresponding role.

NOTE: When logging in using LDAP credentials, make sure to log in using
the domain identifier\username. There can be multiple LDAP
authentication methods added.

5.2.2 ADFS/Azure AD authentication
5.2.2.1 Enabling ADFS/Azure AD authentication

To enable ADFS/Azure AD authentication, proceed as follows:

1. Go to the Security > Authentication tab.

2. In the upper-left corner of the page, click on the Add ADFS/Azure AD
button. The Add authentication method page is displayed.

# Dashboars A Bhcaioh dthodi

3. Fill in the information required for the ADFS/Azure AD authentication
method (for more information, refer to the following knowledge base
article).

4. To test the configuration, click on the Test configuration button.
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5. To add the ADFS/Azure AD authentication method, click on the Save

button.

EDIT ADFS / AZURE AD

More information on how to int=grate with ADFS and Azure AD & svailable here.

Mame ADFS TEST
( Enabled /This authentication method is snabled)
Authentication type ADFS
T
Domain identifier testl

ADFS [ Azure AD FederationMetadata xmil file

Certificate valid from 2020-01-107T10:03:11 000Z
Certificate valid to 2021-01-09T10:03:11 000Z
Application ID (0o

Client secret (O a

=l

NOTE: When logging in using ADFS/Azure AD credentials, verify that you
log in using the domain identifier\username. There can be multiple
ADFS/Azure AD authentication methods added.

For more information about the ADFS/Azure AD feature and integration

with the Portal, refer to the following knowledge base article.
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5.3 Enable logging

The Portal offers thorough audit logs (audit trails).

The audit logs contain the following security-relevant data:

e The date

e Time and activity of each user including sign-in events
e User creation and removal

¢ Role assignments

e Account configuration

e Remote control sessions

e File transfers and others

NOTE: The audit log data is stored for a period of six months. This means
that the data that exceeds the fixed period is automatically removed. This
is done in a chronological order — older data is removed and the more
recent is maintained.

Audit logs help you monitor data for any potential security breaches or
internal misuses of information. Moreover, the audit logs available in the

Portal provide an insight into how various parties are using the Portal.

NOTE: Audit logs containing information regarding connections between a
Guest or Control through browser option and a Host are sent only by
Windows Hosts version 12.67 or later.
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5.3.1 Enabling audit logging

Audit logging is enabled by default within the Portal. If for any reason it is
disabled for your account, go to the Security > Account security tab,
click on the Edit button and enable it. To manage audit logging,

administrator or higher rights are required.

EDIT ACCOUNT SECURITY x
Multi-Factor Authentication Enabled (it can be enabled per user)
receive an email message containing a verification code
Logging Enabled (Logging is enabled)
Save

5.3.2 Retrieve Audit Logs

The audit logs provide valuable information about the users’ activity in the
Portal.

NOTE: Account managers or higher can view and generate log reports.
Account administrator or higher is required to delete a log report.

To retrieve the audit logs, go to the Security > Logs tab and click on the

Generate report button.

A Dashboard All Reports 2 8 Generate report
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Select the date interval:

GEMNERATE LOG REPORT X
From 2022-03-30 5
To 2022-04-02 =

Click on the Generate report button. A new report is created as a * . csv file
containing all events logged within the selected date interval and it is
displayed as a new log entry in the Logs page.

Once you generate a log report, from the Status column, click on the
corresponding Download link. On download, choose to save the report on the
disk.

To make the report readable, open a blank workbook in Microsoft Excel and
import the * . esv file by connecting to it (from the Data tab and from the Get
and Transform Data toolbar, click on From Text/CVS). Make sure that you
use the comma (,) as a column delimiter and the apostrophe () as the text

qualifier.

For more information on understanding the report, refer to the following

knowledge base article.
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6 Account Configuration

The Account > Configuration tab allows the configuration of the Account
details and the Account owner as well as modify the Portal logo. Only an
Account Owner user type can manage and modify the account

configuration.

6.1 Account details

The account details contain information on the actual Portal account such
as:

e The company name

e The contact details

e The account administrators

e The Timezone

e The default remote control action

e The Connection Manager

& CONFIGURATION 2 ContactNetop | ¥ Purchase |

%" My sessions
2 My devices

B My mobile devices

nnnnnnnn

Default remota control action

Account owner

image dimension: 400px x 100
pes: JPG, PNG and SVG

Upload

ACCOUNT
£ Configuration
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To edit them, click on the Edit button.

EDIT ACCOUNT DETAILS

Company Natop

Contact details test

Administrators John Do X UpgradeDevice Reveked X

John Doe x Andrei Cucos X

Timezone Europe/Bucharest
Default remote control Control through browser
action

To save your changes, click on the Save button.

Netop Portal User’s Guide

To set up the default remote control action for all the users, proceed as

follows:

1. Click on the Default remote control action drop-down menu.

EDIT ACCOUNT DETAILS

Company Netop

Contact details

Admimestrators ohn Doe X JpgradeDevice Revok
e X A x

Timezone Europe/Bucharest

Default remote control Control through browser

achon

Control through Guest

Control through browser

2. Select the default remote control action according to

your needs.
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3. Click on the Save button to save your changes.

EDIT ACCOUMT DETAILS

Company MNetop

Contact details pest

Aadrmineciratesers LhnDeos ¥ pnyrade Deere Jevnked W
X A : =B

Timezone EvropefBucharest

Musfaplt romats control Ciervtgl thirough Gasgt

aclison

Sava
I S

6.2 Change the account owner

To change the Account Owner, proceed as follows:
1. Login to the Portal with an Account Owner.
2. Go to the Account > Configuration tab.

3. Click on the Change owner button in the top-right of the screen.

Ve ™~
ACCESS 33 CONFIGURATION 2 ContactNetop = | ¥ Purchase | 1/5 1/2 4450
\_ /
%' My sessions
& My devices o I| = # Edit # Change owner

B My mobile devices
@  Account details

MANAGE

Company
4% Users
Contact details
& Devices
Timezone
L} Groups
Default remote control action Control through Guest

& Applications Administrators

¥ Roles N New

Connection Manager Py .
&v Role assignments

@ Account owner
® Downloads

Account owner
SECURITY
@ Account security Customize your experience in the Connect Portal by adding your own logo

- R Logo 4:1 (Sidebar menu, Error page download pages)
# Authentication Recommended image dimensian: 400px x 100px

Accepted file types: JPG, PNG and SVG

. Max file size: 0.3MB

B Logs Upload

ACCOUNT

§ Configuration
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4, Select a user to become the new Account owner and click on the Save

button.

CHANGE ACCOUNT OWNER

ARE YOU SURE YOU WANT TO CHANGE THE ACCOUNT OWNER?

Select Account Owner Select Account Owner

6.3 Change Portal logo

As the Account Owner you can modify the logo of the Connect Portal. This

can be achieved by going to the Configuration tab.

Customize your experience in the Connect Portal by adding your own logo

Rectangular logo 4:1 (Sidebar menu, Error page and Ondemand/Host download pages)
Recomment ded image dimension: 400px x 100px
Accepted file types: JPG, PNG and SVG

Max file size: 0.3MB m

Square logo 1:1 (Collapsed Sidebar menu and Ondemand client)
Recommen ded image dimension: 256px x 256px

Accepted file types: JPG, PNG and SVG

Max file size: 0.3MB

Click on the Upload button to upload your custom logo.
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7 How to contact the Netop support team

The Portal allows users to directly contact an Netop representative in

order to receive help as fast as possible.

To contact the Netop support team, proceed as follows:

1. Click on the Contact Netop button at the top of the page.

NI/ ™
0

e ™
(= Purchase )
\ /

@ DASHBOARD 2 Contact Netop 44/50

A Dashboard

ACCESS

(& Devices & Users [ Activity

Devices Users

%’ My sessions

Noo e

& My devices

B My mobile devices

MANAGE % Account info (Q Recent updates

4t Users Company Dragos Bantu Account R=N) April 29th, 2025
* Downtime notification - we will be offline on Thursday, May 8th, between 20:00 - 21:00 UTC, while we

2 xpiration date 2026-12-31 @ systs 1prove
Devices Expiration d mak mimp n ml ’ }
wher P
o Grnups Account owner [ tu @gr .com}
REW) April 24th, 2025
Timezone ute - Allimper i appl il F he pr
@ Applications teri L (https
wi
@© Documentation s Mass n for Intel vPro Devices in the Netop Portal. Managing large fleets just

¥ Roles

ate or deactivate Intel vPRO devices in a single action

. e Settings & Hardware Info in the Netop Portal section by
2» Role assignments

@ Downloads

SECURITY

@ Account security

2. This will open the Support Portal where you can Submit a request.

N t I <> Submit a request Sign in

Knowledge Base

Netop Support

Resources for Netop troubleshooting and support

Documentation & Downloads

Netop manuals, guides, and downloads

Promoted articles

Whitelisting Applications for Netop Portal

Download Netop for Windows, Linux and Mac

Netop Manuals & Guides
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